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Preface

This publication is for customers who are installing and using Oracle’s StorageTek 
Virtual Operator Panel (VOP) with a T-series tape drive not being monitored by a 
Service Delivery Platform (SDP) or an encryption-capable LTO4/5 tape drive. 

Note – When an SDP is installed on site and monitoring T-series 
drives connected to the Ethernet private network, the drive 
Ethernet port is 100% dedicated to the SDP. Therefore, the drive 
Ethernet port is unavailable for the customer connection that is 
required for VOP to interface with the drive. 

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/support/contact.html or visit http://
www.oracle.com/accessibility/support.html if you are hearing impaired.

http://www.oracle.com/support/contact.html
http://www.oracle.com/accessibility/support.html
http://www.oracle.com/accessibility/support.html
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What’s New

The changes to the VOP application since the previous edition of this guide are 
detailed below:

Version 
Number Description of Changes

1.0.16 • Oracle rebranding

• HP encrypting LTO-5 support 

• Capability to save the ID file

• Delete all files in the FTP Temp directory on startup

• Added Collect Support Logs shortcut (the S character)

1.0.17 • Updated information to include support for the T10000C tape 
drive

• Revised the download instructions for the Oracle E-Delivery site

• Moved the JRE installation instructions to Appendix C

1.0.18 • Added the Identify commands to the Drive Operations menu

• Removed Zero Drive command from the Drive Operations 
menu

• Encryption of the ID file

• Windows 7 support

• Unified password support

T10000A/B drives running code level 1.48.xxx and a T10000C 
drive running 1.53.xxx require VOP version 1.0.18, or higher.

Note – VOP 1.0.18 does work with code levels 
before 1.48.xxx (T10000A/B) and 1.53.xxx 
(T10000C).

The password change resulted in instruction modifications for 
Chapter 3.
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1

Virtual Operator Panel Overview

Introduction
The Virtual Operator Panel (VOP) facilitates user communication with a T10000 tape 
drive, a T9840D tape drive, or supported Linear Tape Open (LTO) Ultrium tape 
drives. Use the VOP Graphical User Interface (GUI) to display drive information, to 
configure the drive, or to perform various drive operations and functions. There are 
two versions of the application: VOP (supports T10000A, T10000B, T10000C, and 
T9840D tape drives) and LTOVOP (supports generation 4 and 5 drives). 

FIGURE 1-1 shows the T-series VOP (Windows OS) after connection to a drive. When 
connected to a T10000C tape drive, the Active or Hibernate indicator is also present.

FIGURE 1-1  T-series VOP Application Window  

Illustration call-outs (6):
1. Menu bar 
2. Drive IP/name 
3. Primary drive message window 
4. Secondary drive message window 
5. VOP message pane 
6. Drive status indicators 
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Note – VOP on the Linux or UNIX OS is similar but with a 
Linux/UNIX look and feel. 

T-series VOP Application Window
The application window in FIGURE 1-1 on page 15 contains the following sections:

• The menu bar contains the names of the menus. The File and Help menus are the 
only available menus before you complete a drive connection. The Drive 
Operations, Retrieve, and Configure menus have sub-menus and commands that 
are available after VOP connects to a drive. Note that you must place the drive 
offline to access certain functions in the Drive Operations and Configure 
submenus.

• The drive name area displays the drive name or IP address (10.0.0.1 in this 
example). 

• The primary and secondary drive message windows show drive status, host-
generated messages, error messages, and so on. 

• The VOP text message pane displays the VOP transcript.

• The drive status indicators show drive conditions (see TABLE 1-1).

TABLE 1-1  Drive Status Indicators  

Indicator Color Meaning

All Black Indicates no connection to a tape drive.

Loaded or 
Unload

Blue Indicates that a cartridge is loaded in the drive.

Grey Indicates that a cartridge is present in the loading slot, but NOT loaded in 
the drive.

Magenta Indicates cartridge loading/unloading is in transition.

Empty Grey Indicates that a cartridge is NOT present in the loading slot.

Online or 
Offline

Blue Indicates that the drive is online (label reads Online).

Grey Indicates that the drive is offline (label reads Offline).

Magenta Indicates online/offline is in transition.

Clean Orange Indicates that the drive needs to be cleaned. 

Dump Orange Indicates that there is a dump present for retrieval. 

Encryption1

Red Indicates that the drive is encryption-enabled and has all keys (label is 
Enabled).

Orange Indicates the drive is either missing an encryption key (label indicates 
Media for KMS 2.0) or has not been enrolled (label indicates Unlicensed for 
KMS 2.0).

Active or 
Hibernate

Blue Automatic hibernation has been activated.

Grey The drive is in the hibernate state.

1. The encryption status indicator is present only with an encryption-capable drive.
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Note – See Chapter 4, “VOP Operation—T-series Tape Drives” for 
additional information.

LTOVOP Application Window
The LTOVOP (Windows OS) is shown in FIGURE 1-2 after connection to a drive. The 
main parts of the window are:

• Title bar 

• Connect button 

• Four drive status indicators: Online, Empty, Service, and Encrypt 

Note – The Online and Empty indicators are in a different order 
than those of the T-series VOP.

• Four tabs: Monitor Drive, Enroll Drive, Configure Drive, and Service Drive. 

FIGURE 1-2  LTO-4/LTO-5 VOP Application Window 

Note – LTOVOP on the Linux or UNIX OS is similar but with a 
Linux/UNIX look and feel.
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Whereas VOP for the T-series drives has several menus, the only true menu in the 
LTOVOP appears when you click on the logo in the upper left corner of the title bar 
(see the figure below). Use the property sheets in the main body of the window to 
complete various enrollment, configuration, and drive service tasks or to monitor the 
drive (see Chapter 5, “VOP Operation—LTO”).

FIGURE 1-3  Window Control Menu - LTOVOP

Prerequisites 
Before you can install and operate the VOP application, your system must meet 
certain prerequisites. 

Computer Hardware Requirements 

• 512 MB memory 

• 1.0 GHz processor 

• Monitor screen resolution 1024 x 768 (minimum)

• Ethernet port available for static IP addressing

• RJ45-RJ45 Ethernet cross-over cable (direct connection to a drive or drive tray) 

• RJ45-RJ45 Ethernet cables (connection through an Ethernet switch)

Note – See Appendix B, “VOP to Drives on Private Networks” for 
guidelines regarding an indirect Ethernet connection.
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The picture below shows an SL3000 modular library system drive tray (LTO4 drive). 
Notice the Ethernet port in the lower left corner of the LTO encryption-capable drive 
tray. Above the Ethernet port is the STATUS indicator and an IP RESET switch. The 
T9840D and T10000 tape drives have similar items but they might be located 
differently on the drive tray.

FIGURE 1-4  Drive Tray Ethernet Port 

Your computer must be configured with a static IP address that is compatible with 
the target drive. 

Note – See Appendix A, “Changing the Computer IPv4 Address” 
for guidelines.

When you have Ethernet connection to a drive and a compatible static IP on your 
computer, you are ready to operate VOP.

Secure Configuration 

The VOP is designed to operate on a service network configured as a private LAN. 
VOP, tape drives, the Crypto Key Management Appliance (if drives are encrypted), 
and Ethernet switches are potential components of the private LAN. The private 
LAN best practice recommendation ensures security from unauthorized access. See 
the Oracle Key Manager, Systems Assurance Guide for details regarding the service 
network.

Operating System Requirement 

The VOP works on the following operating system levels: 

• Linux–Redhat 9.0, ES 

• Solaris–SunOS 5.8, SunOS 5.9, and SunOS 5.10
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• Windows 2000, XP, or 7 

Note – It is unlikely that platforms with older operating systems 
meet the minimum hardware requirements (see “Computer 
Hardware Requirements” on page 18).

Java® Runtime Environment Requirement 

The VOP software application is a Java-based program. Therefore, you need a 
compatible version of Java Runtime Environment (JRE™) installed on your computer. 

Note – Your computer must have version JRE 1.5, or higher, to 
properly install and run VOP release 1.0.10, or higher. See “Java 
Software Installation” on page 119 for additional information.

Before attempting to install and run VOP, verify the presence, and release level of 
JRE.

• On a Windows OS, open the Control Panel, and double-click Add and Remove 
Programs.

• On a Linux/UNIX OS, see your system administrator.
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2

Software Installation

This chapter provides instructions to install/update the customer (system 
administrator) version of the Virtual Operator Panel (VOP). 

VOP Application Software 
The VOP application software installation process consists of four parts:

• Downloading the latest VOP version (zip file)

• Extracting (unpacking) the zipped (compressed) contents

• Installing and launching VOP 

• Performing post-installation options

▼ To Download a VOP Zip File 

Begin the VOP installation process by downloading the latest VOP version release 
level zip file from the designated download resource.

1. Create a local sub-folder for the VOP download.

Create the folder as a direct subordinate to the root (home folder in Linux/UNIX) 
and name it VOP_download or another name of your choice.

2. Download the latest version of the program from Oracle’s E-Delivery web site.

Note – Use the following URL: http://edelivery.oracle.com/

http://edelivery.oracle.com/
http://edelivery.oracle.com/
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a. Choose your language and click Continue. 

Note – The images for the E_Delivery site are for illustration 
purposes only. The actual presentation might be different than 
shown.

b. Enter your personal information on the Export Validation screen. 
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c. Scroll down the page and agree to the terms and conditions.

d. Choose Oracle StorageTek Products and Generic Platform on the Media Pack 
Search page. 

e. Click GO.

f. Select VOP from the list of available products, and click Continue. 
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3. Click Download to save the VOP zip file to the folder created in Step 1. 

When the download to your local disk completes, you can exit from the web page.

▼ To Extract VOP Files

Note – The example procedure uses the Windows OS as a 
representative example and might not be completely accurate for 
other OS types.

There are several methods of extracting the VOP folders/files from the zip file. The 
following example is modeled on the Windows XP operating system and the IZArc 
utility. The following procedure uses the most direct method to extract the VOP files 
within the download folder.

1. Open the sub-folder that you created in Step 1 of “To Download a VOP Zip 
File” on page 21.

2. Right click on the zip file. 
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3. Point to 7zip and click Extract to VOPfilename.

The VOP files are extracted into the folder. 

Note – The zip file contents will vary relative to the specific VOP 
version. 

The example above shows four install files, each one for a different host (Linux-
x86, Solaris-SPARC, Solaris-x86, and Windows). Each file is executable.
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VOP Installation 

Note – The example procedure uses the Windows OS as a 
representative example and might not be completely accurate for 
other OS types.

VOP software installation consists of the following activities:

• Installing the software

• Launching each VOP program

• Performing post-installation options

Note – VOP version 1.0.15 is used as a representative example of 
the installation process. The primary installation differences 
between VOP versions are filenames, the actual installation 
program, and the quickstart links and desktop shortcuts created 
by the installation program.

▼ To Perform an Installation for the Windows OS

The automatic setup process installs VOP program files within the Windows Program 
Files structure and creates a Start Menu path for launching the program.

1. Double-click the executable (.exe) Windows file.

An information dialog box appears. 
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2. Click Yes to continue.

The installation wizard window appears. 

3. Click Next, accept the license agreement, and click Yes. 

Note – The installation wizard for some VOP releases provides a 
dialog box offering to remove the previous version of VOP.

4. Specify the directory for the wizard to install the VOP files. 

5. Click Next to continue. 

The copy files screen appears.
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6. Click Next to continue. 

Installation progress information appears on the screen.

7. Click Finish on the Wizard Complete screen. 

Note – The number of desktop and Quickstart shortcuts can vary 
from one VOP release to the next.

The VOP program (versions prior to 1.0.18) launches. 

Note – VOP 1.0.18 presents the Authentication dialog box. 
Because you are not able to connect to a drive at this time, click 
the Cancel button to move forward.
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Note – There is a noticeable delay when you open the VOP 
application for the first time of every PC power-on session due to 
the anti-virus scan. 

 

Note – Connection In Progress appears in the two drive message 
windows, but the application is open without actually initiating a 
drive connection. Notice that the Drive Name is NONE and all 
status indicators are black.

8. Determine the Java version.

a. Open the Help menu and click About.

The Drive About Dialog box opens.
 

b. Confirm the release level in the Java Version field.

If the release level is not correct, replace it with the proper level.

9. Click OK or use the ALT+O keyboard shortcut to close the About dialog box.
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10. Exit the program.

Note – Click the “X” in the upper right corner, use the Exit 
command in the File menu, or use the keyboard shortcuts (ALT+F 
to open the file menu and SHIFT+E to exit). 

▼ To Test Launch the ltoVOP Program, Windows

The ltoVOP program is available in VOP 1.0.12 or higher. The following example uses 
the ltoVOP.bat file to launch the program for the Windows operating system. Other 
methods are usually available to launch the program.

1. Open the VOP folder.

2. Double-click the ltoVOP.bat file. 
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The LTO Virtual Operator Panel window opens. 

Note – The VOP version number appears near the center of the 
GUI title bar.

3. Exit from the ltoVOP program.
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VOP Post-Installation Options, Windows

When you have confirmed the VOP programs open, you can optionally delete down-
unneeded VOP files. 

▼ (Optional) To Delete Unneeded Windows Files 

Note – After you have confirmed the newest version of the VOP 
programs are fully functional, it is considered best practice to 
remove/delete unneeded VOP folders. 

The following procedure removes/deletes unneeded VOP program files: 

1. Delete the VOP_download folder:

a. Open the root folder.

The VOP_download folder you created to hold and extract (unzip) the VOP 
program folders and files is listed. 

b. Right-click the VOP_download folder and choose Delete.

The Confirm Folder Delete dialog box appears. 

c. Click Yes to confirm or No to cancel.

After the VOP_download folder is deleted, it no longer appears in the folder 
tree.



VOP Application Software

September 2011 Software Installation  33

 

2. Delete VOP executable files for the operating system that is not in use.

• ltoVOP.bat and sunVOP.bat are used with the Windows operating systems.

• ltoVOP and sunVOP are used with Solaris or Unix operating systems.

The figure below has the ltoVOP and sunVOP files identified. You might want 
to delete these files when VOP is installed on a Windows system. 
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3

Starting VOP Programs

This chapter assumes that the Virtual Operator Panel (VOP) operates with an 
Ethernet connection to a single tape drive. See Appendix B, “VOP to Drives on 
Private Networks” for additional guidelines when operating VOP within a multiple-
drive private network.

For basic hardware requirements and a description of the drive connection, see 
“Computer Hardware Requirements” on page 18.

Early versions of the VOP application provided an operator panel for only the 
T10000A tape drive. Now it provides an operator panel for other T-series tape drives 
(T10000A, T10000B, and T9840D) and also enables encryption enrollment of various 
tape drives.

Overview
This chapter contains instructions for starting the VOP applications on a Windows 
platform. Because the operating systems provide multiple means to start (launch) the 
VOP applications, you can choose any one of those listed: There are two versions:

• T-series VOP

• VOP Application for LTO Tape Drives 

Note – Specific instructions are not provided for other operating 
systems. 

T-series VOP 
You can start the VOP application in the following ways:

• “To Use the Windows Start Menu, Programs List” on page 36 

• “To Use the Desktop Shortcut” on page 37

• “To Use Windows Explorer” on page 38. 

• “To Use the Run Dialog Box” on page 38

See Chapter 4, “VOP Operation—T-series Tape Drives” for detailed information on 
using the application.
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T10000A/B drives running code level 1.48.xxx and a T10000C drive running 
1.53.xxx require VOP 1.0.18, or higher.

Note – VOP 1.0.18 does work with code levels before 1.48.xxx 
(T10000A/B) and 1.53.xxx (T10000C).

▼ To Use the Windows Start Menu, Programs List 

During VOP installation, the installation wizard created a pointer in the start menu 
program list to the executable VOP files.

1. Click Start, point to All Programs, and the Single Drive VOP folder.

Note – Older versions of VOP listed the folder name as VOP.

Other selections appear for LTO VOP, VOP, and to uninstall VOP. 

Note – The installation process for certain versions of VOP 
provides a quick start for LTOVOP. 

2. Click the pointer name (Single Drive VOP).

Make sure to select the VOP option if multiple options are present.

With VOP releases prior to 1.0.17, a window opens (FIGURE 3-1) while release 
1.0.18 presents the Authentication dialog box (FIGURE 3-2 on page 37). 

Note – There is a noticeable delay for the VOP application 
window to open for the first time of every PC power-on session 
while your anti-virus scans. Subsequent VOP launches, in the 
same powered session, are quicker. 

The application appears in a separate window as shown in the following figure. 
However, a drive connection has not been established. The key indications that 
VOP is not connected to the drive are that only two menu names are blue, the 
Drive Name = NONE, and all status indicators are black.

FIGURE 3-1  VOP, Not Connected (Windows Version)
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3. Enter the IP address of the drive and click Connect. 

FIGURE 3-2  Authentication Dialog

Note – For VOP releases prior to 1.0.18; select Connect to Drive 
from the File menu, enter the IP address, and click OK.

The application window updates to show a drive connection (FIGURE 4-2 
on page 44).

▼ To Use the Desktop Shortcut 

1. Double-click the shortcut icon.

With VOP releases prior to 1.0.17, a window opens (FIGURE 3-1 on page 36) while 
release 1.0.18 presents the Authentication dialog box. 

Note – The installation wizard generally creates a desktop 
shortcut. The icon might vary from one VOP release to another.

2. Enter the IP address of the drive and click OK or Connect, as applicable.

Note – For VOP releases prior to 1.0.18; select Connect to Drive 
from the File menu, enter the IP address, and click OK.
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▼ To Use Windows Explorer 

You can start VOP from Windows Explorer:

1. Navigate to the VOP folder, then double-click the sunVOP.bat file. 

With VOP releases prior to 1.0.17, a window opens (FIGURE 3-1 on page 36) while 
release 1.0.18 presents the Authentication dialog box (FIGURE 3-2 on page 37). 

2. Enter the IP address of the drive and click OK or Connect, as applicable.

Note – For VOP releases prior to 1.0.18; select Connect to Drive 
from the File menu, enter the IP address, and click OK.

▼ To Use the Run Dialog Box 

Use the following guidelines to launch VOP from the Run dialog box:

1. Click Start.

The Start menu opens.

2. Click Run. 

The Run dialog box opens.
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3. Do one of the following:

• Enter the path to the VOP executable file.

• In the Open list, click a previous entry.

• Click Browse to locate the desired VOP executable file.

4. Click OK.

With VOP releases prior to 1.0.17, a window opens (FIGURE 3-1 on page 36) while 
release 1.0.18 presents the Authentication dialog box (FIGURE 3-2 on page 37). 

5. Enter the IP address of the drive and click OK or Connect, as applicable.

Note – For VOP releases prior to 1.0.18; select Connect to Drive 
from the File menu, enter the IP address, and click OK.
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VOP Application for LTO Tape Drives

You can start the ltoVOP application in the following ways:

• “To Use Windows Explorer” on page 41 

• “To Use the Windows Desktop Shortcut Icon” on page 41 

• “To Use the Windows Run Dialog Box” on page 41 

• “To Use the Windows Start Menu, Programs List” on page 42 

The application appears in a separate window as shown in the following figure.

FIGURE 3-3  LTO-4/LTO-5 Virtual Operator Panel (Windows Version)

Note – At this point, the application is open, but a drive 
connection has not been completed. The key indications that VOP 
is not connected to the drive are the lack of an IP address in the 
title bar, the grey color of the Connect button, and all status 
indicators are black.

See Chapter 5, “VOP Operation—LTO” for detailed information on the ltoVOP 
application.
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▼ To Use Windows Explorer 

You can start ltoVOP from Windows Explorer

• Navigate to the VOP folder, then double-click the ltoVOP.bat file. 

The ltoVOP opens (FIGURE 3-3 on page 40).

▼ To Use the Windows Desktop Shortcut Icon 

• Double-click the shortcut icon. 

The ltoVOP window opens (FIGURE 3-3 on page 40). 

▼ To Use the Windows Run Dialog Box

1. Click Start.

2. Click Run. 

The Run dialog box opens.
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3. Do one of the following:

• Enter the path to the desired VOP executable file.

• In the Open list, click a previous entry.

• Click Browse to locate the desired VOP executable file.

4. Click OK.

The ltoVOP window opens (FIGURE 3-3 on page 40). 

▼ To Use the Windows Start Menu, Programs List 

During VOP installation, the installation wizard created a pointer in the start menu 
program list to the LTOVOP executable file.

1. Click Start, point to All Programs, and the Single Drive VOP folder. 

Note – Older versions of VOP listed the folder name as VOP. 

Note – The installation process for certain versions of VOP 
provides a quick start for LTOVOP. Make sure to select the VOP 
option if multiple options are present.

2. Click the pointer name (Single Drive LTO VOP).

The LTO VOP window opens (FIGURE 3-3 on page 40). 

Note – There is a noticeable delay for the LTO VOP application 
window to open for the first time of every PC power-on session 
while your anti-virus scans. Subsequent VOP launches, in the 
same powered session, are quicker. 
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4

VOP Operation—T-series Tape Drives

This chapter describes operation of the Virtual Operator Panel (VOP) over a direct 
connection to the Ethernet port of a T9840D or T10000 tape drive (see FIGURE 4-1). 
See Appendix  B for additional guidelines when operating VOP within a multiple-
drive private network. The VOP does not interact with the host data input/output 
interface. 

The VOP has three basic operational functions:

• Monitor drive status

• View or change drive configuration settings

• Use drive operation utilities

FIGURE 4-1  SL8500 Drive Tray Ethernet Port (T-series drive) 

Illustration call-out:

1. Ethernet port

When a Service Delivery Platform (SDP) site unit is installed and monitoring tape 
drives over an Ethernet private network, the drive Ethernet port is 100% dedicated to 
the service network. Therefore, the drive Ethernet port is not available for connection 
to the customer VOP. 
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Note – Many of the sunVOP application window illustrations in 
this section were captured on a Windows XP platform. While the 
Solaris/Linux platform VOP application window has a slightly 
different look, the guidelines apply equally. 

Note – Differences might exist between any illustration in this 
guide and the GUI you are viewing. The VOP version, the tape 
drive model, or the drive code level might produce alternate 
results such as: the number of commands in a given main menu, 
labeling of the encryption status LED, or parameter values for a 
configuration attribute.

Use sunVOP Menus and Controls
The VOP application window provides several menus (see FIGURE 4-2), several 
status indicators, and a text message pane presenting a transcript of the VOP actions 
or a prompt for additional input or actions. 

FIGURE 4-2  VOP Window, Main Menu, and Indicators/Controls (Version 1.0.16)

Note – For VOP versions prior to 1.0.17, when the drive is online 
the label for the Configure menu is dimmed to indicate it is 
unavailable. 

Some status indicators function as an active link to permit you to toggle the state of 
the monitored drive item. 

Note – The following sections provide more detailed guidelines.
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▼ To Use Menu Bar Selections

In general, the following steps are basic for all menus:

1. Identify whether the menu you want to access is available.

Available menu items are blue.

TIP – For VOP versions before 1.0.17, you must set the drive offline to 
access the Configure menu.

2. Open an active menu.

A drop-down list of available commands appears. The drive must be offline to 
execute some commands.

3. Click a command or sub-menu.

The drive message text windows, drive status indicators, and the transcript pane 
provide informational feedback.

TIP – The drive must be offline to perform functions such as Format Tape.

4. Make sure the drive is in the online state before ending a VOP session.

File Menu 
Note – Commands in the File and Help menu are available 
whether VOP is connected to a drive or not, and if connected 
when the drive is either online or offline.

The File menu (FIGURE 4-3) has four commands. A description of each command is 
provided in the following table.

TABLE 4-1  File Menu Commands

Command Description

Clear Transcript Clears the entire VOP transcript pane and closes the file menu. 

Connect to Drive Connects VOP to the tape drive.

Note - You must be connected to the drive before you can use the Drive 
Operations, Retrieve, or Configure menus.

Collect Support Logs Collects drive log files that you can forward to product support for analysis.

Exit Disconnects VOP from the tape drive and closes the VOP window.

FIGURE 4-3  File Menu Commands 
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▼ To Use the Clear Transcript Command

Use the Clear Transcript command to empty the transcript pane.

1. Open the File menu. 

TIP – Choose File from the menu bar or use the ALT+F keyboard shortcut.

2. Click Clear Transcript. 

The entire VOP transcript pane clears and the file menu closes.

▼ To Use the Connect to Drive Command

Use the following guidelines to connect VOP to a designated drive:

1. Open the File menu. 

TIP – Choose File in the menu bar or use the ALT+F keyboard shortcut.

2. Click Connect to Drive or use the SHIFT+C keyboard shortcut.

The Connect to Drive (VOP 1.0.17 and prior) or Authentication (VOP 1.0.18) 
dialog box opens. See FIGURE 3-2 on page 37 for an example of the 
Authentication dialog.

FIGURE 4-4  Connect to Drive Dialog Box

3. (Optional) Enter the drive password, if prompted (see “Security” on page 95).

4. Enter the IP address of the drive in the dialog box and click the OK or Connect 
button, as applicable.

After the VOP establishes connection with the designated drive, the VOP window 
changes to the connected stage.
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In the connected stage, the menu bar contains the drive IP address or alias, additional 
menus are accessible, the status indicators are a color other than black, and the text 
pane/transcript contains message text.

Note – When you connect to a T10000C tape drive, a hibernation 
status indicator is present to the right of the Dump indicator.

5. (Optional) To connect VOP to a different drive, perform the appropriate action:

a. Determine if you are using a crossover cable connection to a single drive:

If no, go to Step b. If yes, perform the following actions:

 i. Disconnect the crossover cable from the tape drive.

ii. Reconnect the cable to a different drive. 

Note – If the drive uses a different IP address, perform Step 2 
through Step 4 to designate the IP address of the new drive.

b. Leave the Ethernet cable connected to the PC private-network switch, and 
designate the new drive IP address (see Step 2 through Step 4). 

Note – The text pane shows that VOP disconnects from the old 
drive and connects to the new Drive IP address.

▼ To Use the Collect Support Logs Command

1. Open the File menu. 

TIP – Choose File from the menu bar or use the ALT+F keyboard shortcut.

2. Click Collect Support Logs.

TIP – With VOP 1.0.16 and higher, you can use the SHIFT+S keyboard 
shortcut.

A text pane message appears after each log is collected, and a final message 
indicates the location of the archive (.zip) message file. Note that an information 
message appears if WinZip is not installed on your PC.

▼ To Use the Exit Command

1. Open the File menu. 

TIP – Choose File from the menu bar or use the ALT+F keyboard shortcut.

2. Click Exit or use the SHIFT+E keyboard shortcut.

The VOP application window closes. If the VOP was connected to a drive, the 
Ethernet connection terminates.
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Drive Operations Menu 
Note – You should consult either the T10000 Tape Drive Operator’s 
Guide or the T9840 Tape Drive User’s Reference Manual for 
additional information regarding the tape drive, use of a cartridge 
tape, and general operating procedures.

You access the Drive Operations commands (FIGURE 4-5 on page 49) from the main 
menu or by using the ALT + D shortcut keys. A description of the commands is 
provided in the following table. The drive must be encryption-enabled for some 
commands to appear.

TABLE 4-2  Drive Operations Menu Commands

Command Description

Load Tape This command loads a cartridge that is presently in the cartridge loading slot.

Unload Tape This command causes a loaded cartridge to rewind and unload. 

Set Offline or 
Set Online 

This command changes the tape drive state. The command name is opposite of 
the current drive state (for instance, Set Offline when the drive is online).

IPL Drive This command starts a tape drive initial program load (IPL).

Force Dump This command dumps the current contents of various drive registers to a file.

Format Tape This command calls a dialog box to reformat a data cartridge as a code tape, 
data tape, or dump tape. It also rebuilds the contents of the tape Media 
Information Region (MIR). The drive must be offline to use this command.

Identify Drive On This command causes the Drive Status indicator to flash (on a T10000A/B 
drive the indicator uses a fast flash rate while the T10000C drive indicator 
changes color between green and blue). The indicator stops flashing after five 
minutes. It was added to version 1.0.18. 

Identify Drive Off This command stops the Identify Drive On command, and the Drive Status 
indication returns to the previous state.

Reset Drive This command is used on an encryption-enabled drive to remove all media 
keys and device keys from the drive. The drive is inoperable until both are 
reloaded.

Note – The drive must be in the reset state to turn encryption off.

Zero Drive This command meets the FIPS requirement to destroy the encryption-enabled 
drive. All keys, including the internal enabling key, are deleted and render the 
drive useless.

Note – This command was removed from version 1.0.18.

Set Power Hibernate This command forces the T10000C tape drive into the hibernation state. The 
status indicator label shows Hibernate and the color is grey.

Set Power Active This command forces the T10000C tape drive out of the hibernation state. The 
status indicator label shows Active and the color is blue. It takes 
approximately 20 seconds for the drive to wake up from the hibernation state.



FIGURE 4-5  Drive Operations Menu (VOP Version 1.0.18 and T10000B) 
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▼ To Use the Load Tape Command 

Use this command to reload a cartridge that was previously unloaded but that was 
not removed from the tape drive loading slot. 

1. Open the Drive Operations menu.

TIP – Click Drive Operations in the menu bar or use the ALT+D keyboard 
shortcut.

2. Click Load Tape or use the SHIFT+L keyboard shortcut. 

The drive loads the cartridge that is present in the tape drive loading slot. A ready 
message appears in the primary drive message window after the tape advances to 
the beginning of tape (FIGURE 4-2 on page 44). A message also appears in the text 
pane to identify that the cartridge is loaded.

▼ To Use the Unload Tape Command 

1. Open the Drive Operations menu.

TIP – Click Drive Operations in the menu bar or use the ALT+D keyboard 
shortcut.

2. Click Unload Tape or use the SHIFT+U keyboard shortcut. 

A loaded cartridge rewinds and unloads. The text pane shows the unload message 
and a message appears in the primary drive message window.

3. Remove the tape cartridge from the drive load slot.

Note – You must physically remove an unloaded cartridge from 
the drive by library robotics or manually from the rack mount 
configuration. Otherwise, the cartridge remains in the loading 
slot, but not loaded into the drive.
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▼ To Use the Set Offline/Online Command 

• When the tape drive is online, this command reads Set Offline. 

• When the tape drive is offline, this command reads Set Online. 

1. Open the Drive Operations menu.

TIP – Click Drive Operations in the menu bar or use the ALT+D keyboard 
shortcut.

2. Click Set... or use the SHIFT+O keyboard shortcut. 

Note – If the drive is in the online state, a dialog box appears and 
you must confirm for the IPL action to continue.

The message pane example below shows when the Set OFF-LINE operation starts 
and when the tape drive is OFF-LINE. As the drive goes offline, the status 
indicator turns gray, the label changes to Offline, and the Offline message appears 
in the primary drive message window.

 

In addition, the label for the Configure menu turns blue.

Note – You can also click the Online/Offline status indicator to 
change the drive state.

▼ To Use the IPL Drive Command

1. Open the Drive Operations menu.

TIP – Click Drive Operations in the menu bar or use the ALT+D keyboard 
shortcut.

2. Click IPL Drive. 

If the drive is online, a dialog box appears. Confirm that you want to proceed with 
the IPL.

The tape drive performs an initial program load (IPL).

Note – VOP loses communications with the drive during the IPL. 
Once the drive IPL is successfully completed, VOP automatically 
reconnects with the drive. 
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▼ To Use the Force Dump Command

1. Open the Drive Operations menu.

TIP – Click Drive Operations in the menu bar or use the ALT+D keyboard 
shortcut.

2. Click Force Dump. 

The drive stores the dump to internal memory, and the dump status indicator 
changes to orange in approximately three minutes. The forced dump operation 
causes a drive IPL, and the VOP loses connection with the drive during the IPL. 
After the drive successfully completes the IPL, FFFA appears in the secondary 
drive message window. See the following figure.
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Format Tape Command

Note – You must load (mount) and unload (dismount) a cartridge 
when you use any of the Format Tape functions. This might 
require you to use a library control path command or utility.

The offline Format Tape command launches a dialog box that provides four utilities 
that are described in the following table. 

TABLE 4-3  Format Tape Utilities 

Function Description

Make data tape The Make Data Tape utility reformats a tape cartridge for reuse as a data tape 
cartridge. Existing headers are removed and the Media Information Region 
(MIR) is rewritten to identify the cartridge as empty and therefore ready for 
write operations.

Make code tape The Make Code Tape utility reformats a tape cartridge with a special format, 
and downloads the drive firmware from the drive memory to the tape 
cartridge. The MIR is then written to identify the cartridge as a code tape. 
You can use the code tape to upload drive firmware to other tape drives. 

The T9840D requires a configuration setting (see FIGURE 4-28 on page 84) 
followed by the loading of a full code image.

Make dump tape The Make Dump Tape utility reformats a tape cartridge with a special 
format. The MIR is written to identify the cartridge as a dump tape. You can 
use a formatted dump tape to download diagnostic dump data from drive 
memory. 

Rebuild MIR You can use the Rebuild MIR utility to repair a data tape cartridge that has 
an invalid or corrupted MIR. The utility reads the file headers all the way to 
the End of Data mark. Then, the MIR is rewritten to correctly reflect the tape 
contents. This utility could take well over one hour to rebuild the MIR on a 
full or nearly full data tape cartridge. 

See “Media Information Region” in the T10000 Tape Drive Operator’s Guide, 
PN 96174 for additional MIR information.

The dialog box also contains three command buttons:

• Make - Initiates the selected utility.

• Abort - You can select this option before you load a cartridge in the drive to 
terminate the utility.

• Done - Closes the dialog box.

Caution – Possible data loss. Do not use a customer data tape to 
make a code tape or a dump tape.
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▼ To Format a Tape Cartridge (Offline)

Use the following general guidelines to perform any of the utilities: 

1. Make sure the drive is offline.

If not offline, perform one of the following actions:

a. Click the Online status indicator. 

b. Open the Drive Operations menu and click Set Offline (see FIGURE 4-5 
on page 49 and “To Use the Set Offline/Online Command” on page 50).

c. Use keyboard shortcut (ALT+D to open the Drive Operations menu followed 
by SHIFT+O to set the drive offline).

2. Click Format Tape.

The Format Tape Cartridge dialog box appears. 

3. Click the appropriate utility. 
 

4. Click the MAKE button or use the ALT+M keyboard shortcut to start the 
selected utility. 

A prompt appears in the transcript directing you to insert a cartridge.

Note – If there is a cartridge in the drive, it unloads. You must 
physically remove the unloaded cartridge.

TIP – Before inserting the cartridge, you can cancel a selected utility by 
clicking the ABORT button or use the ALT + A keyboard shortcut. After 
you insert the cartridge, the utility runs to completion.

Caution – Do not use the Make Code Tape or Make Dump Tape 
functions with a customer data tape.

5. Insert a write-enabled cartridge.

TIP – See FIGURE 4-6 on page 54 for the location of the write-protect 
switch. Make sure the switch is in the write-enabled position as indicated 
by the open padlock icon.



FIGURE 4-6  Tape Cartridge Write-Protect Switch 

Illustration call-outs (3)
1. Write-protect switch
2. Unlocked position
3. Locked position
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The drive performs the selected utility, displays related information in the VOP 
transcript pane, then unloads the cartridge.

6. Remove the unloaded cartridge.

You now have the following options:

• Repeat the current selected format tape command (go to Step 4  on page 53).

• Select a different format tape command (go to Step 3  on page 53).

• Exit the format tape submenu (continue with Step 7).

7. Click the DONE button or use the ALT+D keyboard shortcut to exit the format 
tape submenu.

The Format Tape Cartridge dialog box closes.

▼ To Use the Identify Drive On Command

1. Open the Drive Operations menu.

TIP – Click Drive Operations in the menu bar or use the ALT+D keyboard 
shortcut.

2. Click Identify Drive On. 

The drive status indicator on the rear panel of the drive starts to flash. The drive 
must have the appropriate firmware installed to provide this capability.
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▼ To Use the Identify Drive Off Command

1. Open the Drive Operations menu.

TIP – Click Drive Operations in the menu bar or use the ALT+D keyboard 
shortcut.

2. Click Identify Drive Off. 

The drive status indicator on the rear panel of the drive stops flashing.

T10000C Commands

The Drive Operations menu has additional commands for the T10000C tape drive:

• Set Power Hibernate

• Set Power Active

An indicator for the hibernation function is present to the right of the Dump indicator 
(see FIGURE 4-7). The label for the indicator reflects the current state (Active or 
Hibernate) and is shown in the figure.

FIGURE 4-7  Drive Operations Menu Showing T10000C Tape Drive Differences 

If the hibernation indicator shows Active, you can force the drive into the hibernation 
state by selecting the Set Power Hibernate command. The indicator color changes 
from blue to grey and the label changes to Hibernate.

If the hibernation indicator shows Hibernate, you can force the drive to wake up 
from the low power state by selecting the Set Power Active command. It takes 
approximately 20 seconds for the indicator to change color to blue and the label to 
show Active.
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Retrieve Menu 
The Retrieve menu (FIGURE 4-8) has six commands. You can access the menu by 
choosing Retrieve in the menu bar or by using the ALT+R keyboard shortcut. A 
description of each command is provided in the following table.

TABLE 4-4  Retrieve Menu Commands

Command Description

View Drive Data This command uses selectable property sheets (tabs) to show the current drive 
configuration settings and other drive data.

View Date & Time This command shows the setting of the internal timer in the drive.

ID File to File This command retrieves and saves the ID file to the ID folder in the VOP 
directory.

Dumps to File This command retrieves and saves diagnostic dumps that are currently stored 
in the drive memory.

Perms to File This command retrieves and saves all the permanent errors that are currently 
stored in the drive memory. 

Logs to File This command retrieves and saves event logs that are currently stored in the 
drive memory.

FIGURE 4-8  Retrieve Menu  

Note – The Retrieve menu is available when the drive is online or 
offline.

Additional information is available in the following sections:

• “View Drive Data Command” on page 57

• “To Use the View Date & Time Command” on page 71

• “To Use the ID File to File Command” on page 71

• “To Use the Save Dumps to a File Command” on page 71

• “To Use the Perms to File Command” on page 73

• “To Use the Logs to File Command” on page 73
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View Drive Data Command 

The View Drive Data command uses dialog box pages to show the current drive 
configuration settings and other drive data. The page names for an encryption-
capable drive are:

• Encrypt (encryption-capable drive)

• Fibre - shows either Fibre Channel or FICON properties based upon the interface

• Keyid (encryption-capable drive)

• Maintenance (was added to VOP 1.0.18)

• Manufacturing

• Missing (encryption-capable drive)

• Network

• Power settings to support the T10000C automatic hibernation function

• Rfid (a cartridge must be loaded in the drive) - not available on a T9840D drive

• Version

The View Current Settings window of an encryption-capable drive shows the Encrypt 
page (FIGURE 4-9 on page 58) while a drive that is not encryption-capable shows the 
Fibre page (FIGURE 4-11 on page 60). 

Note – Many of the following pages contain example screens.

▼ To Use the View Drive Data Command

1. Open the Retrieve menu or use the ALT+R keyboard shortcut.

2. Click View Drive Data or use the SHIFT+V keyboard shortcut.

The View Current Drive Settings dialog box appears.
 

Note – The View Current Drive Settings pages are for viewing 
purposes only. See “Configure Menu” on page 74 for detailed 
descriptions and guidelines regarding the changing of any 
configuration setting. 

3. Click the tab for the page that you want to view.

The page shows the current drive settings for that property.

4. (Optional) Click a different page tab. 

Note – Repeat as applicable to gather all required information.

5. Click the OK button or use the ALT+O keyboard shortcut to close the window.
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Encrypt Page

The Encrypt page shows encryption-related data: see FIGURE 4-9 for a T10000 drive 
or see FIGURE 4-10 on page 59 for a T9840D drive. 

FIGURE 4-9  View Current Drive Settings, Encrypt Page (T10000 Drive) 

If you want additional information on FIPS aspects of the drive, see the document 
titled T10000A Encrypting Tape Drive Security Policy, T10000B Encrypting Tape Drive 
Security Policy, or T10000C Encrypting Tape Drive Security Policy.



FIGURE 4-10  View Current Drive Settings, Encrypt Page (T9840D Drive) 
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Fibre Page

The data shown on the Fibre page is specific to the type of drive interface. 
The Fibre Channel Protocol (FCP), shown in FIGURE 4-11, has FCP specific data. The 
Fibre Interface Connection (FICON), shown in FIGURE 4-13 on page 62 has FICON 
specific data. There is a similar list of parameters for a T9840D drive.

FIGURE 4-11  View Current Drive Settings, Fibre Page (FCP Interface) 

 

Note – The T10000C tape drive has additional parameters (see 
FIGURE 4-12 on page 61).
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The Fibre page for the T10000C tape drive has the File Sync Accelerator, Tape App 
Accelerator, and Max Capacity parameters at the end of the parameter list.

FIGURE 4-12  View Current Drive Settings, Fibre Page (FCP - T10000C) 
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The Fibre page for the FICON interface (FIGURE 4-13) is very similar to the FCP 
interface (FIGURE 4-11 on page 60), with the exception of the FICON-specific 
emulation setting.

FIGURE 4-13  View Current Drive Settings, Fibre Page (FICON Interface) 

 

Note – The FICON page for the T10000C drive has additional 
parameters at the end of the list like the FCP property sheet (see 
FIGURE 4-12 on page 61).
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Keyid Page

The Keyid page (FIGURE 4-14) shows a list of key identifiers.

FIGURE 4-14  View Current Drive Settings, Keyid Page 
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Maintenance

The maintenance page shows whether a particular setting is enabled or disabled.

FIGURE 4-15  View Current Drive Settings, Maintenance Page 
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Manufacturing Page

The Manufacturing page (FIGURE 4-16) shows factory preset settings, such as drive 
serial number, and default world wide names.

FIGURE 4-16  View Current Drive Settings, Manufacturing Page 

Note – The serial number of a T10000A drive begins with 531, a 
T10000B drive begins with 572, and a T10000C drive begins with 
576. 
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Missing Page

The Missing page (FIGURE 4-17) shows a list of missing key identifiers.

FIGURE 4-17  View Current Drive Settings, Missing Page 
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Network Page

The Network page (FIGURE 4-18) shows the Network node name. The factory preset 
default is comprised of the drive model number (t10000) and the last nine digits of 
the drive serial number. 

This tab also shows the current static IP settings. FIGURE 4-18 shows factory preset 
static IP parameters, which can be changed through the Configure menu (see 
“Network Page” on page 92).

FIGURE 4-18  View Current Drive Settings, Network Page 
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Power Page

The Power page (FIGURE 4-19) shows the delay time for automatic hibernation and 
whether hibernation is enabled for the T10000C tape drive.

FIGURE 4-19  View Current Drive Settings, Power Page (T10000C) 
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Rfid Page

The Rfid page (FIGURE 4-20) shows data stored in the radio-frequency identification 
(Rfid) memory chip in the T10000 tape cartridge. The Rfid chip stores data related to 
cartridge contents and statistics. The data is similar to data stored in the media 
information region (MIR) on the tape, and is updated with each cartridge mount/
dismount. An Rfid module in the drive reads the Rfid chip while the cartridge is 
loaded, and is viewable (read-only) by the VOP application.

FIGURE 4-20  View Current Drive Settings, Rfid Page 
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Version Page

The Version page (FIGURE 4-21) shows the current firmware and hardware levels.

FIGURE 4-21  View Current Drive Settings, Version Page (T10000B example) 

Note – Depending on the tape drive model, there might be 
additional hardware revision level information.

 



Retrieve Menu

September 2011 VOP Operation—T-series Tape Drives  71

 

▼ To Use the View Date & Time Command

1. Open the Retrieve menu.

2. Click View Date & Time. 

The drive date and time appears in the VOP transcript pane, as shown below.
 

Notice the drive clock setting (8:59) is behind the VOP time on the same text line. The 
drive clock only operates while the drive is powered; therefore, the drive clock time 
can fall behind real clock time whenever the drive is not powered. Most library 
configurations set the drive clock in-sync with the library clock. 

Note – For VOP versions prior to 1.0.17, set the drive offline to 
access functions in the Configure menu.

See “To Use the Set Clock Command” on page 74 to change the drive clock setting.

▼ To Use the ID File to File Command

1. Open the Retrieve menu.

2. Click ID File to File. 

The file is saved to the ID folder in the VOP directory.

▼ To Use the Save Dumps to a File Command

1. Open the Retrieve menu. 

2. Click Dumps to File.
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The save dialog box appears to allow you to name the file and identify where to 
save it.

3. Name the file, specify the target folder, and click Save.

The operating system saves the dump file in the specified location. The VOP 
transcript (shown below) documents the action, including the path to the file. 

Note – The dump indicator dimmed after retrieval of the dump 
file. However, the dump is still present in drive memory until 
intentionally deleted by a service representative or until the drive 
firmware is updated.
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▼ To Use the Perms to File Command 

1. Open the Retrieve menu.

2.  Click Perms to File.

The save dialog box appears for you to name the file and identify where to save it.

3. Name the file, specify the target folder, and click Save.

The operating system saves the perm file in the specified folder. The VOP 
transcript (shown below) documents the action, including the path to the file.

 

▼ To Use the Logs to File Command 

1. Open the Retrieve menu. 

2. Click Logs to File.

The save dialog box appears for you to name the file and identify where to save it.

3. Name the file, specify the target folder, and click Save.

The operating system saves the log file in the specified folder. The VOP transcript 
(shown below) documents the action, including the path to the file.

 



Configure Menu

74  VOP Customer User’s Guide September 2011 

 

Configure Menu
The Configure menu (FIGURE 4-22) has four commands. You can access the menu by 
choosing Configure in the menu bar or by using the ALT+C shortcut keys. A 
description of each command is provided in the following table. 

TABLE 4-5  Configure Menu Commands

Command Description

Drive Data This command allows you to change configuration settings.

Save Drive Config This command allows you to save the current drive configuration 
settings to a file. You can retrieve the saved file to restore configuration 
settings.

Set Clock This command allows you to set the drive’s internal clock to the current 
time in your computer. With VOP version 1.0.17 and higher, this 
command can be performed while the drive is online.

Firmware Update from 
Tape

This command allows you to update the drive’s firmware to the release 
level contained on a prerecorded code tape (cartridge).

Note – Most of the menu commands are performed on an offline 
drive, and the drive should not be available to the host when you 
exercise any change that results in the drive performing an Initial 
Program Load (IPL) to implement the configuration change. 

Additional details are provided in the following sections:

• “Online Configuration Options” on page 74

• “Offline Configuration Options” on page 75

Online Configuration Options

The Set Clock command is available when the drive is either online or offline.

▼ To Use the Set Clock Command 

1.  Open the Configure menu from the menu bar or use the ALT+C keyboard 
shortcut.

The Configure menu label must be blue to allow menu selections with VOP 
versions prior to 1.0.17. For older versions of VOP, place the drive offline to 
access functions in the Configure menu. 

2. Click Set Clock. 
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The drive internal clock is set to your computer’s clock (see the transcript entry).
 

Offline Configuration Options

The Configure menu commands are available after the drive is offline

• “Drive Data Command” on page 75

• “To Use the Save Drive Config Command” on page 96

• “To Use the Firmware Update from Tape Command” on page 97

FIGURE 4-22  Configure Menu

Note – The drive must be offline to perform most of the menu 
commands, and it should not be available to the host when you 
exercise any change that results in the drive performing an Initial 
Program Load (IPL) to implement the configuration change. 

Drive Data Command

Note – The current drive parameter settings were selected by the 
installation team to match pre-determined site requirements. 
Changing the drive parameter setting could materially affect drive 
performance. Therefore, you should change drive parameter 
settings only as instructed by your IT manager or StorageTek 
Support.

The Drive Data command presents you with the Configure Drive Parameters dialog 
box to change configuration settings. When you select a page (tab), the current drive 
parameter values appear. If you change a setting, the adjacent Update checkbox 
indicates a pending change. Deselecting the checkbox cancels the pending change of 
only that parameter.

The following figure shows the Fibre page with a language change to Francais, and 
the corresponding check mark in the Update column. 
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Notice that there are a variety of methods to define parameter values:

• Lists 

• Options

• Text fields

Across the bottom of the Configure Drive Parameters dialog box, there are three 
command buttons that directly affect drive configuration settings. The buttons are 
described in the following table.
 

TABLE 4-6  Configure Drive Parameter Buttons

Button Description

Load Drive Config This function allows you to retrieve a previously saved file containing drive 
configuration parameters/settings. After the retrieved file is opened, all tabs 
are populated with the saved configuration parameter values/settings. 
Marked Update checkboxes identify changed parameter values/settings.

Note: The imported saved configuration file includes parameters specific to 
the originating drive. Make sure you clear or reset drive-specific parameters to 
accurately reflect the drive that imported the saved configuration file.

See “To Use the Save Drive Config Command” on page 96 for guidelines on 
saving a drive configuration.
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Note – During the commit process, VOP loses connection to the 
drive when IPL begins. However, VOP automatically reconnects 
to the drive after a successful IPL.

After the drive completes IPL and VOP reconnects to the drive, you should review 
the Drive Data tabs in the Retrieve menu to verify the new parameter values/settings 
(see “View Drive Data Command” on page 57). If required, place the drive offline 
and repeat the configuration process. 

▼ To Use the Drive Data Command - Manual Entry

1. Open the Configure menu from the menu bar or use the ALT+C keyboard 
shortcut.

2. Click Drive Data or use the SHIFT+D keyboard shortcut.

The multi-tab Configure Drive Parameters dialog box appears.
 

3. Click the tab for the parameters that you want to change.

Note – The Encrypt page opens for an encryption-capable drive or 
the Fibre page opens for drive that is not encryption-capable.

4. Enter a change.

A mark appears in the check box in the Update column to the right of your 
change.

TIP – Repeat this step as necessary to identify additional changes.

5. (Optional) Click the tab for a different page and enter your change(s).

Note – You can use the Cancel button or the ALT+N keyboard 
shortcut to cancel all pending changes.

6. Click the Commit button or use the ALT+C keyboard shortcut.

The drive performs an IPL to implement the identified change(s).

Commit Initiates a drive IPL to activate pending changes.

Cancel Clears any/all pending change selections for all four tabs.

TABLE 4-6  Configure Drive Parameter Buttons

Button Description
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▼ To Use the Drive Data Command - Config File 

1. Open the Configure menu from the menu bar or use the ALT+C keyboard 
shortcut.

2. Click Drive Data or use the SHIFT+D keyboard shortcut.

The multi-tab Configure Drive Parameters dialog box appears. 

Note – Depending on the tape drive model and firmware level, 
additional tabs might be present.

3. Click the Load Drive Config button or use the ALT+L keyboard shortcut to 
import a saved configuration file. 

A dialog box appears where you enter the file name and path or use the browse 
function. The property sheets are populated with data from the retrieved file.

4. (Optional) Remove the check or alter unneeded parameter changes imported 
from a configuration file.

TIP – Pay particular attention to the drive-specific parameter values on 
each of the property sheets.

Note – You can use the Cancel button or the ALT+N keyboard 
shortcut to cancel the pending changes.

5. Click the Commit button or use the ALT+C keyboard shortcut.

The drive performs an IPL to implement the identified change(s).
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Encrypt Page

The Encrypt page contains information about the encryption characteristics of the 
drive (such as, use of tokens or permanently encrypting) and enrollment information. 
FIGURE 4-23 shows the page for a T10000 drive and FIGURE 4-24 on page 80 shows 
the page for a T9840D drive. 

FIGURE 4-23  Configure Drive Parameters, Encrypt Page (T10000 Tape Drive)

Note – See either the encryption documentation for guidelines on 
how to use this property sheet or the T10000 Tape Drive Operator’s 
Guide for information on using Data Path Key Management 
(DPKM).

If you want additional information on FIPS aspects of the drive, see the document 
titled either T10000A Encrypting Tape Drive Security Policy, T10000B Encrypting Tape 
Drive Security Policy, or T10000C Encrypting Tape Drive Security Policy.



FIGURE 4-24  Configure Drive Parameters, Encrypt Page (T9840D Tape Drive)
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Fibre Channel Fibre Page

The Fibre page (FIGURE 4-25) contains drive Fibre Channel configuration settings for 
the T10000A tape drive. The parameters are similar for the T10000B or T9840D tape 
drive. However, the T10000C has additional parameters (see FIGURE 4-26 
on page 82).

Notice that there are three different selection methods on the Fibre tab:

• List boxes - Emulation, Language, Pa/b max recv size, and Pa/b speed 
negotiation.

• Options - Data compression, Data security erase, Standard Label protect, Tape 
completion display, Pa/b hrd asgn phys addr, and Pa/b soft asgn phys addr.

• Text fields - Library address and World Wide Name (drive, ports A & B).

FIGURE 4-25  Configure Drive Parameters, Fibre Page (FCP)

Note – See FIGURE 4-27 on page 83 for the FICON Fibre tab.
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The Configure Drive Parameters dialog box contains a page for the T10000C tape 
drive power functions (see FIGURE 4-26). In addition, the Fibre page has two 
additional parameters: File Sync Accelerator and Tape App Accelerator.

FIGURE 4-26  T10000C Configure Drive Parameters, Fibre Page (FCP)
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FICON Fibre Page

The FICON Fibre page for a T10000 tape drive (FIGURE 4-27) or a T9840D tape drive 
(FIGURE 4-28 on page 84) contains drive FICON configuration settings. 

Notice that there are three different selection methods on the Fibre tab:

• List boxes - Emulation, Language, Pa/b max recv size, and Pa/b speed 
negotiation.

• Options - Data compression, Data security erase, Standard Label protect, Tape 
completion display, Pa/b hrd asgn phys addr, and Pa/b soft asgn phys addr.

• Text fields - Library address, and World Wide Name (drive, ports A & B).

FIGURE 4-27  Configure Drive Parameters, Fibre Page (FICON)

Note – See FIGURE 4-25 on page 81 for the FCP Fibre tab.
 

The Fibre page for the T10000C FICON tape drive also has the additional parameters 
(File Sync Accelerator and Tape App Accelerator) and the drive power page just as 
the FCP configuration (see FIGURE 4-26 on page 82).



FIGURE 4-28  Configure Drive Parameters, Fibre Page (T9840D) 

Configure Menu

84  VOP Customer User’s Guide September 2011 

 

 

The following sections provide additional detail for parameter settings.

Note – The current drive parameter settings were selected by the 
installation team to match predetermined site requirements. 
Changing the drive parameter setting could materially affect drive 
performance. Therefore, you should change drive parameter 
settings only as instructed by your IT manager or StorageTek 
Support.

Emulation

The available emulation options are specific to the active interface and the tape drive 
model.

Note – The option list nomenclature or the specific options 
available might differ from those shown based upon the version of 
drive microcode.
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FIGURE 4-29 shows a representative list of T10000A Fibre Channel options: Standard-
FIBRE, 9840B-FIBRE, 9940B-FIBRE, and 3592-FIBRE.

FIGURE 4-29  T10000A Emulation Options - FCP

Note – Available emulation options can vary with drive model 
and firmware version.

FIGURE 4-30 shows a representative list of T10000A FICON options: VSM3490-
FICON and 3592-FICON. 

FIGURE 4-30  T10000A Emulation Options - FICON

Note – T9840D emulation options are different.

Data Compression

TABLE 4-7 provides a description of the available data compression options.

TABLE 4-7  Data Compression Option Descriptions

Option Use/Meaning

No Data is not compressed, by default, but can be overridden by the 
host for a job.

Yes Data is compressed, by default, but can be overridden by the host 
for a job. 

Off Data compression is disabled by default, and cannot be overridden 
by the host. 

Note – Data compression radio buttons are mutually exclusive. 
The option defaults to the last saved selection. Yes is the factory 
setting.

The following figure shows the data compression options.
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Data Security Erase

TABLE 4-8 provides a description of the available data security erase options.

TABLE 4-8  Data Security Erase Option Descriptions

Option Use/Meaning

Yes Enables a full data security erase. A random binary pattern is 
written on the media, over-writing existing data, from the point of 
an “Erase” command to the End of Tape mark. 

No Writes an end of data mark on the media that indicates valid data 
does not exist beyond the point of an “Erase” command. Data is 
actually still present beyond the end of data mark, and it can be 
retrieved by special tape utilities.

Note – The data security erase radio buttons are mutually 
exclusive. The option defaults to the last saved selection. Yes has 
been the factory setting since June 2008 (drives manufactured 
before that date were set to No). 

The following figure shows the data security erase options.
 

Standard Label Protect

TABLE 4-9 provides a description of the available standard label protect options.

TABLE 4-9  Standard Label Protect Options

Option Use/Meaning

No Disables standard label protection. 

Yes Enables standard label protection. 

Note – 

Consider the following: 

1. Select Yes if label overwrite code is loaded, or if running standard labels and 
wish the drive to display a fatal error (CHK 33EX) when writing a non-80-byte 
record for VOLSER or HDR1.

2. Select No if you are using NL or NSL tape processing.

3. POST WRCART cannot be run with Yes selected

Note – The standard label protect radio buttons are mutually 
exclusive. The option defaults to the last saved selection. No is the 
factory setting. 

The following figure shows the options. 
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Library Address

The Library Address is a text field that contains a two-character hexadecimal value 
that the factory sets to ff as shown in the following figure. 

Note – The setting should remain at ff for all libraries except the 
9310 PowderHorn Library. A valid entry for the 9310 is based 
upon the tape drive position in the 9741/9741E drive cabinet (00 
through 09 [top, down], left column; or 0A through 13 [top, down] 
right column) as viewed from the access door of the cabinet.

Tape Completion Display

The Tape completion display provides an indication of tape completion (percentage 
of tape media with written data) as shown in the following figure.

Note – The view-only tape completion display is superseded by 
higher priority messages that require use of the secondary 
window.

When you select No, the tape completion display is disabled.

When you select Yes, the tape completion display appears in the secondary drive 
message window when there is a cartridge loaded in the drive. 

The available options are shown in the following figure.
 

Note – The radio buttons are mutually exclusive. The option 
defaults to the last saved selection. No is the factory setting. 
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Language 

Note – English is preset at the factory.

The available language selections are shown in the following figure. 

This option sets the language in which certain operational drive messages (such as 
loading, unloading, etc.) appear in the drive message windows. 

World Wide Name 

Caution – Indiscriminately changing the WWN could result in the 
drive being unavailable to the host. 

The World Wide Name (WWN) identifies the drive node. This string of 16 
hexadecimal characters (FIGURE 4-31) represents a 64-bit, unique identifier that 
distinguishes the individual drive from all other devices worldwide. Characters 2 
through 6 identify the specific manufacturer. StorageTek branded devices have the 
company ID “00104F”. Other characters reveal additional drive-specific information. 

FIGURE 4-31  World Wide Name Text Field

Note – When a customized WWN is active, ‘(custom)’ appears in 
the label.

Manufacturing assigns a block of three WWNs (from a pool of company-specific 
WWNs) to each tape drive during the manufacturing process. One for the drive and 
one each for the two fiber-optic interface ports. The drive node is assigned the first 
WWN of the block, and the next two WWNs, in sequence, are assigned to the ports. 
Notice the last two characters in FIGURE 4-31 are 9d. If you refer back to the entire 
fibre tab (FIGURE 4-25 on page 81, FCP or FIGURE 4-27 on page 83, FICON) the port 
A WWN ends with 9e, and the port B WWN ends with 9f. In addition, the (default) 
indicates that this WWN was preset at the factory. 

Certain libraries override the default WWN with a library-assigned dynamic WWN 
(dWWN). Typically, only the last four characters differ from the default WWN. When 
dWWNs are active, (library) appears in the label. 

You can also manually override the WWN with a custom WWN. In some 
circumstances, a service representative might customize a replacement drive’s WWN 
to be the same as the replaced, defective drive’s WWN. This precludes a requirement 
for a full system reset to acknowledge a new WWN.
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Note – If you apply a custom WWN to the drive node, custom 
WWNs must also be applied to the interface ports.

Attributes of Interface Ports

Note – Port physical address attributes are only used when the 
drive is in an arbitrated-loop. The settings are not applicable when 
the drive is in an interface fabric.

There are two identical interface port attribute groups (FIGURE 4-32):

TIP – Pa = Port A, Pb = Port B

FIGURE 4-32  Interface Port Attributes

Hard-assigned Physical Address (No/Yes)

When Yes is selected, the drive uses a specified hard physical address (PA). 
When No (factory-preset default) is selected, the drive seeks a soft PA.

Arbitrated Loop Address (loop ID)

This entry (0 - 125) specifies the loop ID when the Hard PA selection is Yes. 
Factory-preset defaults are: 0 for Port A, 1 for Port B.

Soft-assigned Physical Address (Hi/Lo)

Soft PA is valid when the Hard PA selection is No. 
When Soft PA is Hi, the drive seeks an available loop ID in a descending order.
When Soft PA is Lo (factory-preset default), the drive seeks an available loop 
ID in a descending order.

Maximum Receive Size

Caution – POTENTIAL DRIVE DAMAGE. Older versions of VOP 
display several size options. The smaller size options are not valid 
with the T10000 drive. Furthermore, an attempt to switch to any 
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setting other than 2112 or 2048, could cause the drive to fail to 
complete the IPL. DO NOT select a size option other than 2112 or 
2048.

The maximum receive (max recv) size value, shown in the following figure, 
determines the maximum data frame size for data processing. 

The radio buttons are mutually exclusive. The option defaults to the last saved 
selection.

Note – 2112 is the factory setting. Do not change the value unless 
directed by your IT manager or StorageTek Support.

▼ To Enable the Port World Wide Name Override

Each port has a unique WWN (see FIGURE 4-33) that you can override. See “World 
Wide Name” on page 88 for additional information/detail.

FIGURE 4-33  Port World Wide Name Text Fields

Note – If you apply a custom WWN to the drive node, you must 
also apply custom WWNs to the interface ports.

Note – When a customized WWN is active, (custom) appears in 
the label.

Speed Negotiation

Note – Do not change the speed setting unless directed by your IT 
manager or StorageTek Support. 

The Speed Negotiation options depend on the capability of the interface transceiver 
present in the drive. The following figure shows the options available for a 4 Gbit 
drive.

• When you select Auto, the drive operates at the negotiated interface speed, which 
is typically determined by the slowest attached device. Auto is preset at the 
factory. 



Configure Menu

September 2011 VOP Operation—T-series Tape Drives  91

 

• When you select a fixed rate, the drive only operates at the specified speed and 
might cause the drive to be unavailable, unless all other interface devices are set to 
the same speed. 

File Sync Accel

The StorageTek File Sync Accelerator (FSA) allows applications to reduce or eliminate 
back hitches that are normally caused by writing a tape mark or other sync 
operations. Click the appropriate button to enable or disable the feature.

Tape App Accel

The StorageTek Tape Application Accelerator (TAA) avoids back hitches by 
converting tape marks to buffered tape marks and syncs to NO-OPs. The feature is 
only available with FICON. Click the appropriate button to enable or disable the 
feature.

Note – This feature must only be used in environments that 
handle deferred errors. When this feature is enabled, sending a 
tape mark does not ensure that data has successfully been written 
to the tape. A deferred error may be reported when buffered data 
is written to tape after the command has completed. In a FICON 
only environment, duplex write operations should use this 
feature.

Max Capacity

Maximum capacity allows the use of tape capacity that is normally reserved to ensure 
tape-to-tape copy operations succeed. Enabling this feature can increase cartridge 
capacity by five to ten percent.
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Network Page

The Network page (FIGURE 4-34 on page 92) provides network related options. 
When you select the Network tab, the current settings appear. The information in the 
following figure is from a T10000 tape drive. The parameter list in the dialog box can 
vary based upon the VOP version and the drive microcode level.

Note – The entries shown in FIGURE 4-34 on page 92 are preset at 
the factory, and they should only be changed at the direction of 
your IT manager.

The dialog box for the T9840D tape drive is similar, but instead of the Network node 
name parameter there are two parameters (MIM host IP address and MIM file path).

FIGURE 4-34  Configure Drive Parameters, Network Page

▼ To Set a Drive Static IPv4 Address 

Note – If your drive is monitored by a Service Delivery Platform 
(SDP), the SDP incorporates a dynamic host control protocol 
(DHCP) server that assigns a dynamic IP address to the drive. 

You cannot directly connect the customer VOP to drives 
monitored by an SDP.



Configure Menu

September 2011 VOP Operation—T-series Tape Drives  93

 

The parameters shown in the following table determine the static IPv4 addressing for 
the drive. Each parameter has four 3-digit groups, factory preset to the value shown 
in the table.

Parameter Factory Preset Valid Entries

IP address 010.000.000.001 000 - 255 (each 3-digit group)

Subnet mask 255.255.255.000 000 - 255 (each 3-digit group)

Gateway 000.000.000.000 or 255.255.255.255 000 - 255 (each 3-digit group)

For drives not monitored by an SDP, use the following procedure to edit the static IP 
address fields:

1. Overwrite the IP address digits with the specified new digits.

A check mark appears in the Update checkbox.

2. Overwrite the Subnet mask digits with the specified new digits.

3. Overwrite the Gateway digits with the specified new digits.

4. Click Commit, at the bottom of the dialog box.

Commit initiates a drive IPL to implement the changed configuration settings. You 
should click Commit only after completing all drive parameter setting changes.

Note – If you want use VOP with this drive, you must use the 
Connect to Drive process and specify the new IP address (see “To 
Use the Connect to Drive Command” on page 46).

▼ To Set the Network Node Name

This text field (FIGURE 4-35) determines the network node name for the T10000 tape 
drive. 

FIGURE 4-35  Node Name

Note – The factory preset default is: t10000 - <last nine digits of 
drive serial number>.

To set a different network node name:

1. Overwrite the appropriate characters with the specified new characters.

A check mark appears in the Update checkbox.

Note – The factory preset network node name should only be 
changed by specific instructions from your IT manager, or 
StorageTek Support.

If you use a saved configuration file (from a different drive) to 
change settings, clear the update check box. Otherwise, the 
network node name will change, which could negatively impact 
network operations.
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2. Click Commit, at the bottom of the dialog box, if you do not have other 
changes. Otherwise, go to another section to select additional changes.

Note – Commit initiates a drive IPL to affect changed 
configuration settings. You should click Commit only after 
completing all drive parameter settings for change.

Power 

The T10000C drive can automatically hibernate to save power when a cartridge has 
not been mounted for a specified period of time. When hibernating, the drive cannot 
detect the presence of a cartridge. Therefore, some external action must be taken to 
wake the drive so it can detect when a cartridge is present and load it. Normally, the 
library monitors whether a drive is hibernating and commands a drive to wake up 
whenever a mount is about to take place.

Note – SL3000 code level FRS_3.00 and SL8500 code level 
FRS_7.00 fully support the T10000C hibernate function.

The default time delay is 30 minutes while the range is zero to 60 minutes, and the 
AutoHibernate manufacturing setting is No.

FIGURE 4-36  Configure Drive Parameters, Power Page (T10000C Drive)
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Security

The Security page contains parameters to set or change the tape drive password.

FIGURE 4-37  Configure Drive Parameters, Security Page (T10000C Drive)

After a drive password is defined, you must enter the password as part of the 
authentication process during VOP startup. 

Note – If there are three successive login failures, the login is 
disabled. A service call is required to reset the password.
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▼ To Change the Tape Drive Password

1. Enter the password in the Current Password field.

Note – If the drive password has not been changed previously, 
type default as the password.

2. Type your password of 8 to 16 characters in the New Password field.

A password must contain one of each of the following character categories:

• Uppercase character

• Lowercase character

• Number

• Special character

Note – ! @ # $ % ^ & * ( ) { } [ ] + = - _ are the valid special 
characters.

3. Type your password in the Re-enter New Password field.

4. Click Commit.

The drive performs an IPL.

▼ To Use the Save Drive Config Command 

1. Create a folder to store the drive configuration file.

2. Make sure the drive is offline.

If the drive is not offline, set it offline.

Note – The Configure label must be blue to allow menu selections.

3. Open the Configure menu from the menu bar or use the ALT+C keyboard 
shortcut.

4. Choose Save Drive Config.

A typical operating system SaveAs dialog box opens.

5. Name the new file, specify the target folder, and click Save.

TIP – Use a file name that differentiates it from similar files or overwrite an 
existing file.

The operating system saves the configuration file in the specified location. You can 
retrieve it with the Load Drive Config command button, on page 75.
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▼ To Use the Firmware Update from Tape Command 

Note – You need a code tape to complete this command (see Make 
Code Tape in TABLE 4-3 on page 52).

The following procedure describes loading code in a T10000 tape drive. The process 
is similar for a T9840D drive but there are some noticeable differences.

1. Make sure the drive is offline.

If the drive is not offline, set it offline.

Note – The Configure label must be blue to allow menu selections.

2. Open the Configure menu from the menu bar or use the ALT+C keyboard 
shortcut.

3. Click Firmware Update from Tape in the Configure menu.
 

A text prompt to insert a code tape appears as a VOP text message, and a 
Firmware Update Progress box appears (see below). 

Note – The progress box has a different appearance when loading 
code in the T9840D tape drive.

4. Insert the code tape/cartridge containing the proper firmware release level.

The Firmware Update Progress box (below) tracks the update.

When the firmware update is completely loaded into the drive memory, the 
progress box disappears, the code tape/cartridge unloads, and a prompt to 
remove the cartridge appears in the VOP text message pane (see below). 
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5. Remove the code load cartridge from the drive load slot.

When the cartridge clears the drive load slot, a drive IPL starts, which will load/
activate the updated firmware level into the drive RAM.

Note – VOP loses connection to drive during IPL, but 
automatically reconnects after IPL completes successfully.

6. View the Drive Data Version tab to verify the updated firmware level.

See FIGURE 4-21 “View Current Drive Settings, Version Page (T10000B example)” 
on page 70.
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Help Menu 
The Help menu has a command that displays information about the virtual operator 
panel and a command to access the Fault Symptom Code dictionaries. 

▼ To Use the About Command

1.  Open the Help menu.

2. Click About or use the SHIFT+A keyboard shortcut.

The Drive About Dialog box (FIGURE 4-38) lists information about the VOP 
application, Java version, lists the drive name and IP address (if connected to a 
drive), and with version 1.0.16 lists the copyright and trademark information.

FIGURE 4-38  About Dialog Box 

3. Click OK or use the ALT+O keyboard shortcut to close the dialog box. 

You can also click the X in the upper-right corner of the dialog box.
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▼ To Use the Fault Symptom Code (FSC) Dictionary

VOP version 1.0.15, or higher, includes the FSC Dictionary command in the Help 
menu.

1. Open the Help menu.

2. Click FSC Dictionary.

3. Enter the four character FSC. 

4. Select the tape drive model. 

5. Click the Lookup button. 

The description of the FSC appears in the transcript pane. 

The dialog box and transcript pane are shown in the following figure.
 

Note – The FSC Dictionary is available with or without a drive 
connection.
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5

VOP Operation—LTO

This chapter provides guidelines for operation of the Virtual Operator Panel (VOP) 
with a single LTO Ultrium tape drive (LTO-4 and LTO-5 are supported). The VOP 
does not provide any interconnection with the host data input/output interface. 

The VOP application window has three basic operational functions:

• Monitor drive status 

• View or change drive configuration settings

• Perform drive service tasks

Use ltoVOP Controls
The ltoVOP graphical user interface (GUI) shown in the figure below provides a 
menu for window control (see FIGURE 1-3), the Connect button, a series of status 
indicators, and several tabs. During the course of selected operations, the VOP text 
message pane located on the Service Drive tab displays a transcript of the VOP 
actions and prompts for additional input.

FIGURE 5-1  ltoVOP Graphical User Interface

The status indicators show the current drive state. The indicators in the figure above 
have the following meanings: 

• Online status indicator is dark blue - the Ethernet adapter card is online

• Empty status indicator is grey - no cartridge is loaded in the drive 
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• Service status indicator is grey - shows that the Ethernet card is communicating 
with the tape drive

• Encryption status indicator is grey - the drive is not enrolled

Some status indicators are also an active link that enables you to toggle the state of 
the monitored drive item. Note that the mouse cursor does not change when you 
place the cursor on that type of indicator.

The GUI provides tooltips that appear when you move the cursor to selected areas on 
the window. The figure below shows the tooltip for the first status indicator (Online). 
The tooltip indicates that the tape drive is online. Use a tooltip to display the 
meaning of a status indicator. 

When you load a cartridge in the drive, the cartridge status indicator (the second 
indicator) color changes to dark blue and the label shows Loaded. In addition, the 
Media Type value appears in the Monitor Drive tab (the example below indicates an 
LTO3-formatted cartridge). 

VOP to Drive Connection

Note – It is assumed that you have a physical connection between 
your processing platform and the Ethernet port on the tape drive 
and that you have started VOP (see “VOP Application for LTO 
Tape Drives”).

When VOP is not communicating with the tape drive, the IP address is missing from 
the title bar, the Connect button is grey, and the four indicators to the left of the 
StorageTek logo are black as shown in the figure below.
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▼ To Connect VOP to the Drive

1. Enter the IP address of the tape drive Ethernet port in the white box beside the 
Connect button.

Note – The factory sets the address to 10.0.0.1.

2. Click the Connect button.

The IP address appears in the title bar, the Connect button color is blue, the 
indicator color is no longer black, and data appears in the Monitor Drive tab (see 
the figure below). In addition, transcript messages appear in the Service Drive tab 
(see FIGURE 5-1 on page 101 for an example).

 

Drive Online/Offline Status

To perform some operations from VOP, the drive must be offline. You can use the 
toggle function of the first status indicator or the Set Online/Offline button located in 
either the Enroll Drive or Configure Drive tabs.
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▼ To Change Drive Status to Offline

1. Determine the current drive state.

If the drive is Online (see the first status indicator in FIGURE 5-1 on page 101), 
proceed with the next step. If the drive is Offline, stop. 

2. Change the drive state to Offline by using one of the following instructions:

a. Click the first status indicator.

b. Click the Enroll Drive tab and click the Set Offline button.

See FIGURE 5-5 on page 107 for the location of the button.

c. Click the Configure Drive tab and click the Set Offline button.

See FIGURE 5-6 on page 108 for the location of the button.

3. Verify that the drive status indicator is Offline

The figure below shows that the first status indicator is grey and the label states 
offline. In addition, the button label in the Enroll Drive tab states Set Online.

FIGURE 5-2  Set Online Button
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Error Messages

Certain actions from the GUI result in error conditions. For example, an error occurs 
if you attempt to place the drive (adapter card) offline while a tape cartridge is 
loaded. The following figure shows the resulting error message.

FIGURE 5-3  Error Message

Read and understand the error message before clicking the OK button.
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Monitor Drive
Click the Monitor Drive tab (see the figure below) to display a list of drive, cartridge, 
and Key Management Station agent attributes and values for those attributes. Some 
attributes require another action, such as drive enrollment for encryption, before the 
associated data appears.

FIGURE 5-4  Monitor Drive
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Enroll Drive
Note – Refer to the encryption documentation before using this 
screen. The sequence for using the Configure Drive and Enroll 
Drive tabs is critical to success.

The Enroll Drive page has a Change Enrollment Settings section and four buttons.

FIGURE 5-5  Enroll Drive

Enter a value in the text field to change an enrollment parameter setting. A check 
mark appears in the checkbox to the right of the text field. If you decide against an 
entered change, uncheck the box and the commit operation ignores that value. 

This process actually enrolls the adapter card instead of the LTO4 tape drive. If a 
service representative replaces the tape drive, no re-enrollment is necessary.

The agent must have already been created with a pass phrase assigned in the 
Crypto Key Management System (KMS) before you can enroll the drive. The KMS 
must be able to communicate with the adapter card and tape drive.

The KMA IP address must be a service network address.

• Set Offline - click this button to set the drive offline. 

Note – The label on this button changes depending on the current 
drive state (for example the label is Set Offline when the drive 
state is Online).

• Commit - saves the enrollment parameter changes in NVRAM. (The Ethernet card 
does not reboot if you only change the enrollment settings.)

Note – Only those fields with an active check box are updated 
when you click the Commit button.

• Enroll - performs drive enrollment after committing the enrollment settings.

• Cancel - clears all pending change selections.
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Configure Drive
Note – Refer to the encryption documentation before using this 
dialog box. The sequence for using the Configure Drive and Enroll 
Drive tabs is critical to success.

The Configure Drive page contains a Change IP Settings section and three buttons 
(see FIGURE 5-6 on page 108). This page is typically used by the service 
representative to configure the drive to use settings other than those set during the 
manufacturing process.

Enter a value in the text field to change an IP parameter setting. A check mark 
appears in the check box to the right of the text field. If you decide against an entered 
change, deselect the box and the commit operation will ignore that value.

• Set Offline - click to set the tape drive (adapter card) offline. 

Note – The label on this button changes depending on the current 
drive state (for example, the label is Set Offline when the drive 
state is Online).

• Commit - click to save the desired IP change in NVRAM (the Ethernet card does a 
reboot when you change an IP setting).

Note – Only those fields with an active check box are updated 
when you click the Commit button.

When the IPL completes, the new IP address is in use. Depending on the IP 
address, you might need to make a similar IP address change for the device 
running VOP.

• Cancel - click to deselect all pending change selections.

FIGURE 5-6  Configure Drive
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Service Drive
The Service Drive page contains a text-based transcript area and seven buttons (see 
FIGURE 5-7 on page 109).

• Support Logs - saves the log files with the name you enter and your specified 
location.

• Clear Transcript - erases the content from the text pane.

• IPL - performs an initial program load of the Ethernet card.

• Run Loopback Test - performs an internal loopback test with the LTO-4 drive. 
Results are posted in the text pane.

• Load Firmware - implements the Ethernet card firmware update procedure. You 
are prompted to identify the directory that contains the Ethernet card firmware 
files.

• Adapter Dump - saves the Ethernet card log file with the name you enter and your 
specified location.

• About - provides information about the VOP version, basic drive information, and 
with version 1.0.16 the copyright and trademark information is provided (see 
FIGURE 5-8 on page 110).

FIGURE 5-7  Service Drive

Note – Most of the functions on the Service Drive tab are for use 
by the service representative. Refer to the encryption 
documentation for additional information regarding the use of 
this screen.



FIGURE 5-8  About LTO Virtual Operator Panel
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A

Changing the Computer IPv4 Address

This appendix provides guidelines to set a static IPv4 address required to connect to 
the drive, and to reset a single Ethernet port for obtaining a dynamic IP address. 

Note – If your computer has two or more Ethernet ports, you can 
dedicate one for static IP addressing and leave the one used to 
connect to the LAN set for dynamic IP. 

Static IPv4 Address
To connect VOP to a T10000 tape drive that has a static IPv4 address, you must make 
sure your computer has a functional Ethernet port with compatible static IPv4 
address.

Note – See your system administrator for Linux/UNIX operating 
systems.

▼ Setting static IP, Windows OS

Use the following procedure to check or set a static IP address for your computer:

1. Click Start, point to Settings, and click Network Connections. (FIGURE A-1).

FIGURE A-1  Network Connections Selection
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The Network Connections window (FIGURE A-2) lists all network connections.

FIGURE A-2  Network Connections Window

2. Double-click the appropriate connection.

The Local Area Connection Properties dialog box (FIGURE A-3) opens.

3. Scroll down, select Internet Protocol (TCP/IP), and click the Properties button. 

FIGURE A-3  Local Area Connection Dialog Box

The TCP/IP properties dialog box (FIGURE A-4 on page 113) opens.



FIGURE A-4  Internet Protocol (TCP/IP) Properties Dialog Box
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Note – If the port is set for the proper static IP and subnet mask, 
skip to Step 5. Otherwise, perform step 4 to enter/edit the static IP 
address and subnet mask.

4. Make sure the Use the Following IP Address option is selected, and enter a 
compatible static IP address, Subnet mask, and Default gateway.

See your system administrator, as needed for assistance.

Note – Static IP address 10.0.0.2 is typically used for the computer 
to be compatible with a drive factory preset static IP address 
10.0.0.1. However, if the drive’s static IP has been customized for 
your site, you must set the computer’s static IP to be compatible 
with the target drive. The first three digit sets must match, and the 
last digit set must be different from the target drive. The last digit 
set should also be different than any other possible target drive on 
your site.

5. Click OK.

The Local Area Connection Properties dialog box (FIGURE A-3 on page 112) 
reappears. 

6. Click OK.

You can now connect to any on-site drive that has a compatible static IP address.
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Dynamic IP Address 
If you set a temporary static IP address for an Ethernet port normally used to connect 
to the LAN, you will need to reset the port to automatically obtain a dynamic IP 
address. 

▼Resetting IP to Auto, Windows OS

Use the following procedure to reset a local connection for dynamic IP address: 

1. Click Start, point to Settings, and click Network Connections (FIGURE A-1 
on page 111).

The Network Connections window opens (FIGURE A-2 on page 112).

2. Double-click the Local Area Connection associated with the Ethernet port that 
requires change. 

The Local Area Connection Properties dialog box (FIGURE A-3 on page 112) 
opens. 

3. Scroll-down, select Internet Protocol (TCP/IP), and click the Properties button. 

You will need to scroll down as TCP/IP is the last selection. The TCP/IP 
properties dialog box (FIGURE A-5) opens.

4. Click Obtain an IP address automatically.

The three IP address fields go blank, and become unavailable for entries.
 

FIGURE A-5  Internet Protocol (TCP/IP) Properties (auto IP) Dialog Box

5. Click OK to save the reset.

The Local Area Connection Dialog box (FIGURE A-3 on page 112) reappears. 

6. Click OK.

The Ethernet port is now set to connect to a LAN. 
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B

VOP to Drives on Private Networks

This appendix provides supplemental information about VOP to drives connected on 
an IPv4 private network. 

Private Network, SDP-Controlled
When a Service Delivery Platform (SDP) is present, all monitored drives are 
connected into an IPv4 private network controlled by the SDP site server.

The Ethernet port of every monitored drive is 100% dedicated to the service network, 
and each drive has an SDP-controlled dynamic IP address. Therefore, you do not 
have access to the drive Ethernet port and cannot connect your customer-version 
VOP to such drives.

Note – Only service representatives are authorized to access 
drives connected to an SDP-controlled private network. Never 
disconnect an Ethernet cable associated with an SDP-controlled 
private network. 

Contact your service representative to change drive configuration 
settings of any drive in the SDP-controlled private network.

However, when an SDP site server is not present, your site personnel can 
interconnect drives from one or more drive cabinets into a non-SDP private network. 
See “Private Network, non-SDP” on page 116.
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Private Network, non-SDP
When an SDP site server is not present, a non-SDP private network (FIGURE B-1), 
can be set up, interconnecting the installed drives to one or more cascaded Ethernet 
switches. Such a network allows you to access any connected drive from a central 
point.

FIGURE B-1  Private Network, non-SDP

1. Desktop PC
2. Notebook PC 
3. Ethernet switch
4. T10000 tape drives

Overview

In a non-SDP, customer-controlled private network, the Ethernet port of each drive is 
connected to an Ethernet switch. A desktop and/or notebook PC, running the 
customer-version VOP application, would also be connected to the network.

Note – Each connected drive and each computer requires an 
individual static IP address. 
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Components

The following table lists the required components for operating VOP in a non-SDP 
private network.

Component Description

Computer One or more desktop or notebook computers

Note: The computer(s) must use the single-drive, version of the VOP, and an 
Ethernet port configured with a compatible static IPv4 address.

Ethernet switch(es) One or more Ethernet switches might be required to provide a port for 
each drive, one port for each computer, plus additional ports to cascade 
multiple switches.

Note: See the Ethernet switch vender documentation for setup guidelines. 

Ethernet CAT5 cables One cable for each drive, one cable for each computer, plus additional 
cables to cascade multiple switches with enough length to connect to the 
switch port and allow strain relief.

Ethernet cross-over cable One cross-over cable for direct computer-to-drive connection.

▼ Setup

Consult with your site IT manager, system administrator, and support personnel to 
install and setup the Ethernet components, and obtain the private network static IP 
addresses. 

Note – Each drive should have been preset at the factory with the 
following: 
Static IP address: 010.000.000.001
Subnet mask: 255.255.255.000 
Default gateway: 255.255.255.255
However, it is a good idea to verify the data using the drive data 
property sheet for the network settings in the Retrieve menu of 
VOP.

Use the following procedure to set up each drive for the private network.

1. Set your computer static IP address to 10.0.0.2 and the subnet mask to 
255.255.255.0.

See “Static IPv4 Address” on page 111.

2. Start VOP.

See Chapter 3, “Starting VOP Programs” on page 35.

3. Connect the Ethernet cross-over cable to the computer Ethernet port and to the 
drive Ethernet port.

4. On each installed drive, perform the following steps:

a. Connect VOP to the cabled drive.

See “To Use the Connect to Drive Command” on page 46.
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b. Reset the drive static IP address to one that is compatible with the new 
network and commit the change.

See “To Set a Drive Static IPv4 Address” on page 92. 

c. Disconnect the Ethernet cross-over cable from the drive port.

Note – The VOP does not reconnect to the drive following the IPL 
because the drive static IP is no longer 10.0.0.1.

d. Connect a CAT5 Ethernet cable from the open drive port to an available port 
on the Ethernet switch.

If this is the last drive that needs an IP address change, continue with Step 5.

Note – Any drive can be connected to any available Ethernet 
switch port. It is not necessary to assign ports to specific drives. 
However, you should make a listing of the assigned IP address for 
each drive location.

e. Connect the computer Ethernet cross-over cable to the next drive Ethernet 
port.

The VOP should automatically connect to the drive because it is still 
attempting to reconnect to IP address 10.0.0.1.

5. Disconnect the cross-over cable from the computer. 

6. Reset the computer static IP address to the private network-designated IP 
address.

See “Static IPv4 Address” on page 111.

7. Connect a CAT 5 cable to the computer Ethernet port and to an available port on 
the Ethernet switch.

8. Connect VOP to a selected drive.

See To Use the Connect to Drive Command.

Note – Use the private network-designated drive static IP 
address.

9. Repeat Step 8 for a few different drives.

Note – You only need to enter the other drive’s designated IP 
address into the Connect to Drive dialog box (FIGURE 4-4 
on page 46).

The non-SDP private network is now ready for VOP access to any connected drive.
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C

Java Software Installation

This appendix provides instructions to install/update the Java Runtime Environment 
(JRE). 

To install/update the Java Runtime Environment, go to http://www.oracle.com.

Note – The Oracle web pages are dynamic and subject to frequent 
changes. Therefore, the actual pages you see might differ from the 
examples in this section. 

1. Click the Java for Your Computer link in the Top Downloads area in the lower 
right of the screen.

FIGURE C-1  Oracle Home Page 

www.oracle.com
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A page containing the current Java download appears. 

2. Click Free Java Download.

A page containing a description of the download for your browser appears.
 

Note – A link is present below the Free Java Download button 
that provides access to Java for other operating systems. There is 
also a link for Installation Instructions.

3. Click Free Java Download.

4. Follow the on-screen prompts to start the installation. 
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You can choose to run or save the file. If you choose to run the software, the 
Welcome to Java window appears. 

5. Click Install.

The Java Setup dialog box offers the installation of the Yahoo! toolbar. 

6. Make your selection and click Next.

A progress bar appears.
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An installation complete message appears. 
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Glossary

This glossary defines terms and abbreviations in this publication. 

Some of the definitions are taken from other glossaries. The letters in the parentheses 
that follow some definitions indicate the source of the definition:

(A) The American National Standard Dictionary for Information Systems, ANSI X3.172-
1990, copyright 1990 by the American National Standards Institute (ANSI).

(E) The ANSI/Electronic Industries Association (EIA) Standard-440-A, Fiber Optic 
Terminology.

(I) The Information Technology Vocabulary, developed by Subcommittee 1, Joint 
Technical Committee 1, of the International Organization for Standardization and 
International Electrotechnical Commission (ISO/IEC/JTC1/SC1).

(IBM) The IBM Dictionary of Computing, copyright 1994 by IBM.

(T) Draft international standards committee drafts, and working papers being 
developed by the ISO/IEC/JTC1/SC1.

A
address
A character or group of characters that identifies a register, a particular part of 
storage, or some other data source or destination. (A). 

alphanumeric 
A character or group of characters that identifies a register, a particular part of 
storage, or some other data source or destination. (A).

C
capacity 
Total amount of User Data stored on one data cartridge in 8 bit bytes. Synonymous 
with “User Capacity” or “Native Capacity”. This is the capacity that the user sees 
after the ECC/Format/ERP etc. overhead has been assessed (no compression). 

capacity, raw 
Total amount of data stored on one data cartridge in 8 bit bytes before any ECC/
Format/ERP etc. overhead has been assessed (no compression). 
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capacity, user 
Total amount of data stored on one data cartridge in 8 bit bytes that is sent by the 
host computer. This is the capacity that the user sees after the ECC/Format/ERP etc. 
overhead has been assessed (no compression). 

cartridge
A storage device that consists of magnetic tape on supply and takeup reels, in a 
protective housing. (IBM)

cleaning cartridge
A data cartridge that contains special material to clean the tape path in a transport or 
drive. 

compress
To save space by eliminating gaps, empty fields, redundancy, or unnecessary data to 
shorten the length of records or files. (IBM)

configuration
The manner in which the hardware and software of an information processing system 
is organized and interconnected. (T)

connector
An electrical or optical part that joins two or more other parts.

D
data cartridge
A container holding magnetic tape that can be processed without separating the tape 
from the container. 

data path key management (DPKM) 
The use of the SCSI 4 commands Security Protocol In and Security Protocol Out to 
implement host-based key management encryption on StorageTek tape drives.

data security erase (DSE)
A random binary pattern, over-writing existing data, from the point of an Erase 
command, to the end-of-tape.

data tape
A data cartridge formatted for use as a regular data tape for the system in which it is 
used. 

data track(s) 
The region(s) of recorded tape containing user data formed as discreet longitudinal 
“tracks” (similar to railroad tracks). 

diagnostics
Pertaining to the detection and isolation of errors in programs and faults in 
equipment. (IBM)

DPKM 
See data path key management. 

drive
A device for moving magnetic tape and controlling its movement. (IBM)

dump
To copy the contents of all or part of virtual storage to collect error information. 
(IBM)
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E
emulation
The use of programming techniques and special machine features to permit a 
computing system to execute programs written for another system. (IBM)

encryption 
The translation of data into a secret code. Encryption is one of the most effective 
ways to achieve data security. To read an encrypted file, you must have access to a 
special key or password that enables you to decipher it.

EOT 
End of Tape. 

erase 
To remove data from a data medium, leaving the medium available for recording 
new data. (I) (A) 

error
A discrepancy between a computed, observed, or measured value or condition and 
the true, specified, or theoretically correct value or condition. (I) (A)

ESD 
Electrostatic Discharge. 

F
fault symptom code (FSC)
A four-character hexadecimal code generated in response to an error to help isolate 
failures within the device. 

FC
See fibre channel.

fiber optics
The branch of optical technology concerned with the transmission of radiant power 
through fibers made of transparent materials such as glass, fused silica, and plastic. 
(E)

fiber-optic cable
A cable made of ultrathin glass or silica fibers which can transmit data using pulses 
of laser light. Fiber-optic cables have several advantages over copper cables: they 
have much less signal loss; they allow information to be transmitted at higher speeds 
and over longer distances; they are not affected by external electrical noise; and they 
are better for transmissions which require security.

fibre channel
The National Committee for Information Technology Standards standard that defines 
an ultrahigh-speed, content-independent, multilevel data transmission interface that 
supports multiple protocols simultaneously. Fibre Channel supports connectivity to 
millions of devices over copper and/or fiber-optic physical media and provides the 
best characteristics of both networks and channels over diverse topologies.
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fibre connection (FICON)
An ESA/390 and zSeries computer peripheral interface. The I/O interface uses ESA/
390 and zSeries FICON protocols (FC-FS and FC-SB-2) over a Fibre Channel serial 
interface that configures units attached to a FICON-supported Fibre Channel 
communications fabric.

FICON
See fibre connection (FICON). 

FICON channel
A channel having a Fibre Channel connection (FICON) channel-to-control-unit I/O 
interface that uses optical cables as a transmission medium. 

file-protect
To prevent the erasure or overwriting of data stored on data cartridges.

FIPS
Federal Information Processing Standards

FRU 
Field Replaceable Unit. 

FSC 
Fault Symptom Code. 

FTP 
Generic definition: File Transfer Protocol. 

G
GB
See gigabyte (GB).

Gb
Gigabit, equal to 109 bits.

Gbps
Gigabits per second.

gigabyte (GB)
One billion (109) bytes. 

H
hardware
All or part of the physical components of an information processing system, such as 
computers or peripheral devices. (T) (A)

hub
A Fibre Channel Arbitrated Loop switching device that allows multiple servers and 
targets, such as storage systems, to connect at a central point. A single hub 
configuration appears as a single loop.



September 2011 Glossary  127

 

I
indicator
A device that provides a visual or other indication of the existence of a defined state. 
(T)

interface
Hardware, software, or both, that links systems, programs, or devices. (IBM)

internet protocol (IP)
A protocol used to route data from its source to its destination in an Internet 
environment. (IBM)

internet protocol (IP) address
A four-byte value that identifies a device and makes it accessible through a network. 
The format of an IP address is a 32-bit numeric address written as four numbers 
separated by periods. Each number can be from 0 to 255. For example, 129.80.145.23 
could be an IP address.

IP 
See internet protocol (IP)

internet protocol v4 
(IPv4) address 
A four-byte value that identifies a device and makes it accessible through a network. 
The format of an IP address is a 32-bit numeric address written as four numbers 
separated by periods. Each number can be from 0 to 255. For example, 129.80.145.23 
could be an IP address. 

internet protocol v6 
(IPv6) address 
The next generation internet protocol. It provides a much larger address space than 
IPv4. This is based upon the definition of a 128-bit address - IPv4 used a 32-bit 
address. The IPv6 address format is eight fields of four hexadecimal characters 
separated by colons (for example, 2001:0db8:85a3:0000:0000:8a2e:037
0:7334)

L
library
A robotic system that stores, moves, mounts, and dismounts data cartridges that are 
used in data read or write operations.

Linear Tape-Open (LTO)
A set of data format standards created to enable data interchange among tape drive 
produced by a consortium of manufacturers. With LTO standards, the tape cartridges 
are interchangeable among tape drive brands.

link
A physical connection (electrical or optical) between two nodes of a network.

M
magnetic tape 
A tape with a magnetizable layer on which data can be stored. (T) 



128  VOP Customer User’s Guide September 2011 

 

menu
A list of options displayed to the user by a data processing system, from which the 
user can select an action to be initiated. (T)

N
network
An arrangement of nodes and branches that connects data processing devices to one 
another through software and hardware links to facilitate information interchange.

O
offline
Neither controlled by, nor communicating with, a computer. (IBM)

online
Pertaining to the operation of a functional unit when under the direct control of the 
computer. (T)

P
performance
One of two major factors, together with facility, on which the total productivity of a 
system depends. Performance is largely determined by a combination of throughput, 
response time, and availability. (IBM)

R
read/write head
The data sensing and recording unit of a diskette magazine drive or tape drive. (IBM)

release
A distribution of a new product or new function and fixes for an existing product. 
(IBM)

R/W 
Read/Write.

S
SDP 
Service Delivery Platform. 

submenu
A menu related to and reached from a main menu. (IBM)

sub-system 
A system that is part of some larger system. 

switch
In Fibre Channel technology, a device that connects Fibre Channel devices together in 
a fabric.
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system 
A combination of functionally interrelated interacting mechanical and electrical 
elements designed to work as a coherent entity. 

T
T10000 Tape Drive (VOP)
A software application that allows a user to monitor and perform some operations on 
a tape drive.

tape 
See magnetic tape. 

tape cartridge 
A container holding magnetic tape that can be processed without separating the tape 
from the container. 

tape drive
A device for moving magnetic tape and controlling its movement. (T)

TCP/IP 
Transmission Control Protocol/Internet Protocol

transmission control protocol/internet protocol (TCP/IP)
A set of communication protocols that support peer-to-peer connectivity functions for 
both local and wide area networks. (IBM)

U
Ultrium
An LTO tape format optimized for high capacity and performance with outstanding 
reliability. The Ultrium tape format uses a single reel cartridge to maximize capacity.

V
VOLSER 
VOLume SERial Number. It is, usually 6 characters long and is both the paper label 
stuck on the back edge of the cartridge and in the VOLID label that is recorded, 
particularly by MVS systems, at the beginning of the media. 

volume serial number (VOLSER)
An alphanumeric label that the host software uses to identify a volume. It attaches to 
the spine of a cartridge and is both human- and machine-readable.

VOP
See T10000 Tape Drive (VOP).

W
wrap 
A single pass of tape from either BOT to EOT or EOT to BOT with the head(s) in a 
fixed transverse location. 

write-enabled
A setting on a data cartridge that allows data to be written on the tape.
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write-protected
A setting on data cartridges that prevents data from being written on the tape. 
Reading data is still possible.
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Index

A

abort button, format tape 53
about

button, ltoVOP 109
dialog, VOP 99

adapter dump button 109
application window

VOP, LTO 17
VOP, T-series 15, 119

authentication, dialog (VOP) 37

B

button
ltoVOP

about 109
adapter dump 109
cancel 107, 108
clear transcript 109
commit 107, 108
connect 17
enroll 107
get support logs 109
IPL 109
load firmware 109
run loopback test 109
set offline/online 107, 108

T-series VOP
abort format tape cartridge 53
cancel, authentication dialog 37
cancel, configure command 77
cancel, connect to drive 46
commit configure command 77
connect, authentication dialog 37
done, format tape cartridge 53
done, FSC lookup 100
load drive config 76
lookup 100
make format tape cartridge 53
OK connect to drive 46

C

cancel button
LTO VOP 107, 108
T-series VOP

authentication 37
authentication, password 95
configure drive 77

change
computer IP address to dynamic 114
configuration parameters 75, 84
date & time 74
drive code from tape 97
drive data 75

clear transcript
button, ltoVOP 109
command, T-series VOP 46

collect support logs 47
commit button

ltoVOP (configure drive) 108
ltoVOP (enroll) 107
T-series VOP 77

computer hardware requirements 18
configure

drive password 95
drive, LTO VOP 108
menu, T-series VOP

description 74
drive data 75
firmware update from tape 97
save drive config 96
set clock 74

security 95
connect to drive

dialog box 46
LTO VOP 17, 103
T-series VOP 46

D

data compression 85
date

setting 74
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view 56, 71
dialog box

authentication 37
connect to drive 46
password 95

dictionary, FSC 100
done button 53
download VOP zip folder 21
DPKM 79
drive

change data, T-series drives
command 75
config file 78
encrypt 79
Fibre 81
Fibre (FICON) 83
manual entry 77
network 92
power 94
security 95

code load from tape 97
connect to

LTO VOP 17
T-series VOP 46

date setting 74
Ethernet port, library tray 19, 43
identification indication 48
IPL of T-series 48, 50
password configuration 95
power setting, T10000C 94
status indicators

LTO VOP 17
T-series VOP 16

time setting 74
view data command 56

drive operations menu
description 48
force dump 48, 51
format tape 52
identify drive 48
IPL drive 48, 50
load tape 48
picture of 49
set offline 48, 50
set online 48, 50
unload tape 48

dumps to file
command description 56
procedure 71

dynamic computer address (changing to) 114

E

encrypt tab

change configuration, T-series drive 79
view, T10000 drive 58
view, T9840D 59

enroll
button 107
drive, LTO VOP 107

Ethernet port
SL3000 drive tray 19
SL8500 drive tray 43

exit 47

F

fault symptom code dictionary 100
fibre tab

configure T9840D 84
view FCP 60, 61
view FICON 62

file menu
clear transcript 46
collect support logs 47
connect to drive 46
exit 47
overview 45
picture of 45

force dump 48, 51
format tape

button
abort 53
done 53
make 53

command 52
description

make code tape 52
make data tape 52
make dump tape 52

rebuild MIR 52
submenu 53

G

get support logs button 109

H

hardware requirements 18
help

about 99
FSC dictionary 100
menu 99

I

ID file to file
command description 56
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procedure 71
identify drive 48
indicators, drive status

LTO VOP 17
T-series VOP 16

installation
overview, VOP software 21
procedure

JRE software 119
VOP software 26

Introduction, VOP 15
IPL

button, ltoVOP 109
T-series VOP

command description 48
procedure 50

J

Java Runtime Environment
download 119
minimum release level requirement 20

JRE 119

K

keyid tab 63

L

language 88
load

code from tape 97
drive config, button 76
firmware button, ltoVOP 109
tape, command 48

logon authentication, T-series VOP 37
logs

collect support 47
retrieve to file

command description 56
procedure 73

LTO VOP
application window 17
button

about 109
adapter dump 109
cancel 107, 108
clear transcript 109
commit 107, 108
connect 17
enroll 107
get support logs 109
IPL 109
load firmware 109

run loopback test 109
set offline/online 107, 108

operation 101
start operation

desktop shortcut 41
programs list 42
Windows Explorer 41
Windows Run dialog box 41

tab
configure drive 108
enroll drive 107
monitor drive 106
service drive 109

M

maintenance tab 64
make

button 53
code tape 52
data tape 52
dump tape 52

manufacturing tab 65
menu

configure 74
drive operations 48
file 45
help 99
retrieve 56

missing tab 66
monitor drive, LTO VOP 106

N

network tab
configure 92
IPv6 static address 92
view 67

O

operating system certification 19
operation

LTO VOP 101
T-series VOP 43

P

password
configuration of 95
login dialog box 95

perms to file 56, 73
power tab

configure 94
view 94
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Preface 11
prerequisites 18

hardware 18
Java 20
operating system 19

private networks, overview of (non-SDP) 116

R

rebuild MIR 52
requirements, VOP

hardware 18
Java Runtime Environment 20
operating system 19

retrieve menu
description 56
drive data 57
dumps to file 71
ID file to file 71
logs to file 73
perms to file 73
picture of 56
view date & time 56, 71
view drive data 56, 57

RFID tab 68, 69
run loopback test button 109

S

save drive configuration 96
secure configuration, VOP 19
security 95
service drive, LTO VOP 109
set

clock 74
drive power parameters 94
offline, procedure 50
offline, T-series VOP 48
offline/online button (ltoVOP) 107, 108
online, procedure 50
online, T-series VOP 48

software installation
JRE 119
VOP 21

static address
computer setting, Windows OS 111
IPv6 92

support logs, collection of 47

T

T9840D configure drive settings 84
tape cartridge write-protect switch 54
time

setting clock 74

view, command description 56
view, procedure 71

U

unload tape 48

V

version tab 70
view current drive settings

drive data 57
encrypt tab 58, 59
fibre tab (FCP) 60, 61
fibre tab (FICON) 62
keyid tab 63
maintenance tab 64
manufacturing tab 65
missing tab 66
network tab 67
power 94
retrieve menu 56
RFID tab 68, 69
version tab 70

VOP
application software installation 21
application window

LTO 17
T-series 15, 119

connect to drive
LTO 103
T-series 46

installation 26
Introduction 15
LTO

application window 17
configure drive tab 108
connect to drive 103
enroll drive tab 107
monitor drive tab 106
service drive tab 109
window menu 18

operation
ethernet connection 18
LTO 101
menu bar 45
T-series 43

secure configuration 19
T-series

application window (Windows OS) 15
configure menu 74
drive operations menu 48
file menu 45
help menu 99
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menus, indicators, and controls 44
retrieve menu 56

VOP operation
controls 44
menus, T-series

configure 74
drive operations 48
file 45
help 99
retrieve 56

start
desktop shortcut 37
programs list 36
run dialog box 38
Windows Explorer 38

W

window
menu, ltoVOP 18
T-series VOP (Solaris) 16
T-series VOP (Windows OS) 15, 119

world wide name 88
write-protect switch, tape cartridge 54
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